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Legal notice

This document is an integral part of the software shipped by Qognify (referred to here-
inafter as the vendor) and describes how to use and configure the software and the
associated components.
The English version of the document is the original version. All translations are based
on the English original.

Copyright

This document is protected by copyright. It is not permissible to pass on the information
it contains to third parties without the vendor's expression permission. Any infringe-
ments will result in claims for damages.

Patent and copy protection

In the event of protection being provided by a patent, utility model or registered design,
all rights are reserved. Brand names and product names are trade names or registered
trademarks of their companies or organizations.

Address

Qognify GmbH
Werner-von-Siemens-Str. 2 - 6
D-76646 Bruchsal
Tel: +49 (0)7251/9290-0
Fax: +49 (0)7251/9290-815
Email: info.emea@qognify.com
Internet: https://www.qognify.com

Disclaimer

Subject to alterations without further notice. Suggestions regarding the improvement of
this documentation are welcome. For suggestions, refer to Support.

Legal notice
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Legal notice

Version

This manual corresponds to Qognify VMS 7.5 (Version 7.5.1).
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Login

Once the system is installed, you have to log in on the client to use the installed ser-
vices.
To automate the startup of the client, command line parameters can be defined, e.g. to
start the client with a different language or with predefined passwords.

KEEP THE ADMINISTRATOR'S PASSWORD IN A SECURE PLACE!
If you forget the administrator's password and no additional users have been
added to the administrator group, it is no longer possible to access the system
configuration settings. The administrator password cannot be restored.
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Login

1. Start the Qognify VMS client in the Qognify folder in the Start menu or on the

desktop.

Fig. 1: Login

2. Select the Authentication method. The following authentication methods are

available:

— Basic authentication with user name and password as defined in the con-

figuration within Qognify VMS.
— Windows authentication with the current user credentials of the Windows oper-

ating system, i.e. the same login as required for logging into the system. The

user will have the rights of the groups he is in.
— Windows authentication with the user’s Active Directory (AD) credentials. The

user will have the rights of the groups he is in.

This feature can only be used if the use of Active Directory (AD) is part

of the Qognify VMS license.

3. If Basic Authentication is selected, enter the user name and the password.

Make sure the user name and password are entered correctly, as the sys-

tem distinguishes between upper and lower case (case-sensitive).

4. Apply by clicking the arrow. The client is started in surveillance mode (see "Sur-

veillance mode" on page 79).
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In Viewer mode, Qognify VMS is used for the display of exported data in
Archive mode (see "Anywhere Viewer" on page 139).

All login attempts (successful and failed) are logged in the report view of the
report mode together with the IP or name of the computer used.

The number of failed login attempts is defined in configuration mode by the admin-
istrator. Also, a failed login attempt can trigger an notification, which is also defined in
configuration mode.

Changing the password

When logging in for the first time, you are required to modify the default user pass-
word.

Fig. 2: Change password

1. Enter the User name ("administrator") and default Password ("pass").

2. Enter your new password.

3. Disable Enforce secure password if you do not require increased password

security.

4. If necessary, enter a second password.

5. Click OK.

Changing the database backup password

Database backups are encrypted and require a password. When logging in for the
first time, you are required to modify the default database backup password.

Login
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Login

Fig. 3: Change the database backup password

1. Enter the database backup password.

2. Repeat the new database backup password.

3. Click OK.
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Advanced login options

In the advanced options of the login screen, additional user management functions
or log in as a user with two passwords is configured.

1. Click Advanced options in the login window.

Fig. 4: Advanced login options

The following options are available:

n Last used: list of previously connected servers
n Server: name and port of a different server
n Second password if required for login
n Comment: additional information for the selected login.

Login
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Login

n Remember user name and Remember password: avoids having to enter

the user data for log in. The system enters the specified user name and pass-

word in the login window.

Due to legal regulations, in France the user name and password may

not be saved for installations.

n Log in automatically: displays the user interface when the program starts up

(without log in).
n Use NAT: enables the client to access a different server over the internet.

Deselect this option if no internet connection is required. This option

requires NAT-settings in configuration mode.
n To login to all installations with the same user name and password, select

Use local credentials for all installations. Optionally this option can be activ-

ated in the installation manager (see "Disconnect and reconnect a Qognify

installation" on page 36).

Make sure that the remote user credentials are the same as the local

credentials.

KEEP THE ADMINISTRATOR'S PASSWORD IN A SECURE PLACE!
If you forget the administrator's password and no additional users have been
added to the administrator group, it is no longer possible to access the sys-
tem configuration settings. The administrator password cannot be restored.

Logging in Viewer Mode

The viewer mode provides a way of accessing a reduced set of features in Qognify
VMS without connection to the database and the user directories for viewing expor-
ted data in offline mode.

1. Restart Qognify VMS and select Viewer Mode.

2. Apply by clicking the arrow on the login screen. The client starts in Viewer

Mode.
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The user interface
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The user interface

Fig. 5: The user interface

The user interface is divided into different sections:

n The mode bar (1) allows you to switch between surveillance mode, archive

mode, report mode, configuration mode and LPR mode (see "The mode bar" on

page 76).
n The function bar (2) provides basic operating functions that can vary depending

on the mode used. (see "The function bar" on the facing page). The function bar

also contains the menu (see "The menu items" on the facing page).
n The Work area (3) is the main window for displaying the selected mode func-

tions. The work area can be divided in multiple tabs containing different contents

like cameras, layers, LPR functions etc. (see "Work area" on page 80).
n Information control (4) is displayed in the lower part of the work area. The inform-

ation control is used for the alarm list and system messages (see "Alarm list and

system messages" on page 106) in surveillance mode, and for displaying search

results in configuration mode (see Searching in configuration mode).
n Login information (5) displays which user currently logged in and provides user

switching and easy logout (see "Changing the user" on page 76).
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n The control bar (6) contains the tabs for controlling the contents of the work area

(see "The control bar" on page 77).

The function bar

Fig. 6: The function bar

The function bar provides basic operating functions that can vary slightly depending on
the selected mode:

n Logo toggle ( ): Triggers an action when clicked. The logo action can be con-

figured from the tools menu (see "Configuring a logo action" on page 63).

n Navigation ( ): Opens or closes the navigation menu for the menus File,

View, Tools, Info, Help (see "The menu items" below).

n Day- / night mode toggle ( / ): Switches the background of the user inter-

face darker (night mode) or lighter (day mode). This function is available in all

modes except the configuration mode.

n Layer menu ( ): This function allows the user to create and arrange custom

layers in surveillance mode (see "Custom layers" on page 85).

n User information ( ): Displays the current user and provides functions to log

off or change the user (see "Changing the user" on page 76).
n Current time: Displays the current client time and date.
n Tab selector: Displays all opened layers in tabs for quick access (see "Creating

layers and adding objects" on page 81).

The menu items

The menu items are available in all modes. The display of some menu items depends
on user rights:

n File. Options for changing the settings of the client, the language, password, pro-

file, installation, installation manager, and switches the user (see "File menu" on

the next page).

The user interface

The function bar
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The user interface

The function bar

n View. Manages the settings of the connected monitors and the video wall as well

as the LPR master data (see "View" on page 37).
n Tools. Displays and removes the write protection of recordings, configures the

multiple export of image data and defines the logo action (see "Tools" on

page 47).
n Info Displays information on the system and license (see "Info" on page 66).
n Help. Calls the Help system and provides options for solving problems (see

"Help" on page 75).

File menu

The menu "File" displays the following options:

n Client configuration
n Change language
n Change password
n Change profile
n Change user
n Switch installation
n Installation manager
n Exit

Client configuration

You can specify settings for visualization options, behaviors on user input, network
load etc. with the client configuration.
Modification options for the following categories are available:

The settings of the client are stored locally in the Windows user profile. They
can only be changed by a user with administrator rights.

1. After changing the client configuration, restart the client for the changes to take

effect.
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Client

Fig. 7: Client configuration - Client

Settings

n Disable alarm toast messages to suppress alarm notification for toast

messages (see "Alarm notification" on page 108).
n Disable system notification toast messages to suppress system noti-

fications for toast messages (see "System messages" on page 109).
n Show filtered search results only to display only the relevant search

results in the search results list. (If deactivated, the search results will

be highlighted in the control bar, but all items are displayed.)

The user interface

The function bar
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The user interface

The function bar

n Disable service info dialog for the device finder to suppress the status

information about the "SSDP Discovery" service (SSDPSRV), which

may not be installed on the operating system. This service provides

UPnP (Universal plug and play) support for the DeviceFinder. If the

check box is activated, the user will be asked to install the service if not

already available.
n Show camera media time with milliseconds to display the time in the

archive player with more detail (see "Archive player" on page 112).
n Enable PTZ click to center mode to enable clicking into the live image

of a camera to shift the selected point into the image center using phys-

ical pan/tilt.
n Merge alarm list and system messages to display alarms and system

messages in a single list (see "Alarm list and system messages" on

page 106).
n Web browser to open external links or the online help system.

Report mode

n Maximum number of events in report mode to limit the amount of

events displayed in report mode.

Thumbnails

n Activate for cameras in camera overview to activate the thumbnail

view of the camera image in the camera overview. You can open thumb-

nails by rolling the mouse cursor over the names of the cameras in the

overview while holding down the CTRL key.
n Activate for cameras in maps to activate the thumbnail view of the cam-

era image in the maps. You can open the thumbnail by using the mouse

pointer to hover over the name of the camera in the map.
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n Scale thumbnail size in map with screen resolution. The scaling

adapts the thumbnail size to the screen resolution. The higher the res-

olution of the screen is, the higher will be the resolution of the thumb-

nails.
n Activate for archive timeline displays a small preview image of the

selected time segment when moving the mouse over the timeline in

archive mode. The options are "Off", "Always on" and "Control Key

pressed", with "Always on" as the default setting.

Automatic login for DisplayAgent

n When Activated, the user name and password must be entered to start

the DisplayAgent automatically when the client is started.

Appearance

Fig. 8: Client configuration - Appearance

n Video background color is displayed around a video image if its aspect ratio

is not the equal to the aspect ratio of a view or tile.

The user interface

The function bar
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The user interface

The function bar

n Font colors. The default font colors can be changed
— Color 1 on a dark background
— Color 2 on a light background
— Color 3 on a mixed background like the main menu
— Color 4 on a mixed background like table headings
— Color 5 on a video player border (black background)

n Use default colors reverts to the default settings.
n Tile titlebar font size: The font size in the title of layers or tiles can be

changed.
n Tile Size Thresholds: Sets the thresholds for streaming different resolutions

based on tile size.
n Maximum Size Small Tiles displays the maximum tile size for low

streaming resolution.
n Maximum Size Medium Tiles displays the maximum tile size for aver-

age streaming resolution.
n Tile width for reduced control panel sets the tile width for a min-

imized tile when only the audio controls should be displayed.

Alarms

Fig. 9: Client configuration - Alarms

n Alarm sequence to specify starting with more recent or older alarms when

processing the alarm list.
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n Stop low priority alarms when a new alarm is activated to stop low-priority

alarms (priority 1-4) before the end of the predefined alarm interval is

reached.

High priority alarms cannot be stopped.

n Restore minimized main window when an alarm occurs to restore the

main window in case of an alarm. If this option is not activated, the main win-

dow will not be restored in case of an alarm.
n Sequential alarm window to specify the desired number of rows and

columns to be displayed (see "Adding a sequential alarm window" on

page 39).
n Maximum number of alarms in archive mode to specify the maximum num-

ber of alarms displayed in archive mode (see "Archive mode" on page 111).

Analytics

Fig. 10: Client configuration - Analytics

The tracking data settings are defined as global settings in configuration mode.
They can be activated separately.

1. Select which tracking data should always be displayed in selected camera

images:

n Objects
n Classification
n Counts

The user interface

The function bar
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The user interface

The function bar

n Object path
n Rules

2. Select Always show selected tracking data to display tracking data also in

not selected camera images. This options needs more performance on the

client.

3. Configure the Maximum number of events in LPR mode when searching

for license plates. When the maximum is reached, a warning is displayed.

Increasing the number may lead to sluggish performance and longer

loading times.

Warnings

Fig. 11: Client configuration - Warnings

n Suppress warning about time difference to server to suppress a warning if

there are more than ten seconds of time difference between client and

server.
n Suppress warning about low screen resolution to suppress a warning if the

screen used does not have a high enough resolution.
n Suppress warning about MDS zone full to prevent a warning when the stor-

age depth limit of the multimedia database is reached.
n Suppress warning about different streaming settings in configuration

mode to suppress the warning that recording losses can occur if there are

discrepancies between the settings for standard and alarm recording if not

using a second stream for alarm recording (see Video streams).
n Delete entities without confirmation in configuration mode to delete the

entity (camera, time template, alarm, button, etc.) without receiving a

request for confirmation when you select Delete in configuration mode.
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Network

Fig. 12: Client configuration - Network

The following options are available:

n Timeout for server request to increase the time limit in seconds if the server

does not respond quickly enough.
n Image transmission via the UDP or default TCP port. The UDP port is freely

selectable.

Select UDP only on 100% reliable network connections.

n Bandwidth limitations to limit the bandwidth when accessing DeviceMan-

ager servers with a low-bandwidth connection to avoid overloading the net-

work.

It is not recommended to limit the bandwidth between a client and the

server. Frames will be dropped on a limited bandwidth.

The user interface

The function bar
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The user interface

The function bar

VoIP and SIP

Fig. 13: Client configuration - VoIP and SIP

The Qognify VMS client can act as SIP client to communicate with other clients or
voice units that support the SIP standard.

n SIP base port number (the default is "5060").
n Audio RTP port (the default is "7000").
n Audio input device and audio output device. Regardless of this, incoming

calls go via the operating system's default audio output device.
n Use echo and noise suppression to improve the sound quality.
n Use microphone amplifier to increase the volume of the input device.
n Specific settings for installation displays all existing Qognify installations.
n Use keep-alive packages to adjust the intervals at which the client is to log

in to the SIP or VoIP server. The default value for Keep-alive interval is 10

(s), and for Registration interval it is 3600 (s).
n SIP user name and SIP password for the SIP server.
n Participant name. The participant name is displayed as the called par-

ticipant in archive mode.
n Registration server and Outgoing proxy: IP address of the SIP server.

A SIP server is required.
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Input devices

Fig. 14: Client configuration - Input devices

In this section of the client configuration, input devices like jog dials, joysticks, or
key pads are configured.

The input device or the corresponding device drivers must be installed on
the Windows system before it can be configured.

The input device must be connected to the client computer before the client
starts. Otherwise it will not appear in the client configuration.

Select and display entities with buttons of a input device

1. Connect the device to the USB port of the client computer.

2. Select the device. The device functions are listed on the right-hand side

of the dialog box.

3. Enable Activate the device.

4. Enable the functions, e.g. virtual buttons or virtual sequences.

5. If necessary, activate the z-axis (depending on the hardware, usually

available on joysticks).

6. Press the input device button to which you want to assign an action or

select the buttons number from the list.

7. Select the desired action (for example, when a certain button of the joy-

stick is pressed, a camera or a map is to be displayed in a certain win-

dow of the Qognify configuration).

After confirming the changes, restart the client for the changes to take

effect.

The user interface

The function bar
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The user interface

The function bar

Configuring virtual buttons or sequences of the Axis TU9003

keypad

Using the Axis TU9003 keypad, a camera can be displayed on a local Qognify
window or on a Qognify GmbH DisplayAgent (see "DisplayAgent" on
page 40). To reduce the number of buttons that must be configured, each cam-
era is numbered.
Only one of the following options can be assigned:

n With the option virtual buttons, up to 1000 virtual buttons can be con-

figured for the Axis TU9003 keypad to invoke up to 1011 actions.
n The use of virtual sequences requires a correctly configured entity num-

bering (see Configuring the entity numbering). In surveillance or

archive mode virtual sequences can be started on the keypad (see

examples below).

For a detailed description of the Axis TU9003 keypad functions refer to
the manufacturer's documentation.

1. Select Enable virtual buttons or virtual sequences.

2. With virtual buttons enabled, enter a value for the timeout (ms). Within

this period, the user must press the buttons to execute the configured

action.

3. For buttons or virtual buttons, select any button on the keyboard to dis-

play the assigned button in the list in the column “Number to display”

and define the action from the drop-down menu.

After confirming the changes, restart the client for the changes to take

effect.

Key assignments for keypad TU9003

The keys of the Axis TU9003 keypad are assigned as follows:

F1 Target: Local monitor / window
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F2 Target: Display Agent

F5 Show web page

F8 Target: Tile

F9 Show temporary layer

F10 Show map

Show layer

Show camera

Examples

n 0-F1-1- : Show camera 1 in main window.

n 0-F1-1- : Show layer 1 in main window.

n 0-F1-1-F10: Show map 1 in main window.
n 0-F1-5-F9: Show an empty 2x2 temporary layer window in

main window.

n 1-F8-1- : Show camera 1 in first tile of the current layer.

Configuring virtual buttons or sequences of the Axis T8312

keypad

Using the Axis T8312 keypad, a camera can be displayed on a local Qognify
window or on a Qognify GmbH DisplayAgent (see "DisplayAgent" on
page 40). To reduce the number of buttons that must be configured, each cam-
era is numbered. Refer to the manufacturer's documentation of the keyboard.
Only one of the following options can be assigned:

n With the option virtual buttons, up to 1000 virtual buttons can be con-

figured for the Axis T8312 keypad to invoke up to 1011 actions.

The user interface

The function bar
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The user interface

The function bar

n The use of virtual sequences requires a correctly configured entity num-

bering (see Configuring the entity numbering). In surveillance or

archive mode virtual sequences can be started on the keypad (see

examples below).

For a detailed description of the Axis T8312 keypad functions refer to
the manufacturer's documentation.

1. Select Enable virtual buttons or virtual sequences.

2. With virtual buttons enabled, enter a value for the timeout (ms). Within

this period, the user must press the buttons to execute the configured

action.

3. For buttons or virtual buttons, select any button on the keyboard to dis-

play the assigned button in the list in the column “Number to display”

and define the action from the drop-down menu.

After confirming the changes, restart the client for the changes to take

effect.

The keys of the Axis T8312 keypad are assigned as follows:

n First row:
— F1: Local display
— F2: Display agent
— F5: Web page

n Second row:

— : Predefined layer

— : Camera

— : Tile

— : Temporary layer

— : Maps

n Keypad:
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— 0 - 9: Predefined sequences, buttons or virtual buttons 0...999

— : Toggle between buttons 0...999 and virtual buttons

1000...1011:

n Alt: 1001

n : 1002

n : 1003

n : 1004

n : 1005

n : 1006

n F1: 1007
n F2: 1008
n F3: 1009
n F4: 1010
n F5: 1011

The user interface

The function bar
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The user interface

The function bar

Key assignments for keypad T8312

1. Press the key combinations on the keypad. The first key selects the

entity or number, the second number specifies the entity type or

device type, e.g.:

— Pressing the keys 0 - F1 - 5 - displays camera number 5

on display (F1) number 0, the local main display.

— Pressing the keys 3 - F2 - 1 - displays the predefined

layer number 1 on the display agent (F2) number 3.

— Pressing the keys 1 - F1 - 5 - displays the layer number

5 (a 2x2 layer) on display (F1) number 1 (the local secondary

display).

— Pressing the keys 0 - F1 - 5 - - 45 - displays the

camera number 45 on display (F1) number 0 (the local main

display) in tile number 5.

For improved efficiency when assigning the virtual buttons or
sequences, the software “remembers” the previously assigned loc-
ation, e.g. windows or tiles.

Example

n The keys 0 - F1 - 5 - have been assigned to display

camera 5 on display 0 (see above). Entering next 6 -

will display camera 6 on the same display.

Restrictions and special cases

n The jog dial and shuttle wheel are supported in archive mode for the Axis

T8313 jog dial controller. The Axis TU9001 does not have a jog dial avail-

able.

30 / 144



n If multiple joysticks of the same type are used, the joystick settings can

become mixed up after the update to version VMS 7.5. If this happens,

change the physical connection accordingly.
n It must be made sure that no other application has access to the joystick to

prevent erratic behavior.
n The Videotec DCZ control unit is also supported with the following restric-

tions:
— Only 32 of 38 buttons can be used.
— Only the outer jog dial can be used in archive mode.

Keyboard shortcuts

Fig. 15: Client configuration - Keyboard shortcuts

Custom keyboard shortcuts can be defined for rearranging the client surface.
The following functions can be configured:

n Toggle bottom control bar (default: (CTRL) + 6)
n Toggle right control bar (default: (CTRL) + 7)
n Shrink/Expand overview bar (default: (CTRL) + 8)
n Shrink/Expand control bar (default: (CTRL) + 9)
n Toggle all control bars (default: ESC)
n Full screen (default: F10)
n Push To Talk (default: (CTRL) + A)

For more shortcuts, see "Shortcut keys" on page 137.

The user interface

The function bar
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The user interface

The function bar

Changing the language

The following languages are available for the user interface and the help system:

n English
n Czech
n Danish (only user interface)
n Dutch
n French
n German
n Greek (only user interface)
n Hebrew
n Italian
n Japanese (only user interface)
n Norwegian (only user interface)
n Polish
n Portuguese (only user interface)
n Russian
n Romanian
n Spanish
n Swedish (only user interface)
n Thai (only user interface)
n Turkish

Additionally, you can define the user interface with a user defined language
(see "Technical_Guides_Qognify_Qognify VMS_7.5_EN.pdf").

1. Select Change language from the File menu.

2. Select the desired language. If you select Windows default, the operating sys-

tem language is used.

3. Click OK to apply the selection, and restart the client.

Changing the password

You can change the user's password at any time, depending on the user rights.
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1. Choose Change password from the File menu.

Fig. 16: Changing the password - 1

2. Enter the password for the current user and click OK.

Fig. 17: Changing the password - 2

3. Enter the new password.

4. Click OK to apply the password.

The user interface

The function bar
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The user interface

The function bar

Changing the profile

If multiple profiles are used (user profile, group profile, etc.), you can change to a dif-
ferent profile. The profiles can be managed in configuration mode.

Fig. 18: Changing the profile

1. Select Change profile and the desired profile.

2. Click OK to confirm. The current profile is logged off, and the selected profile is

activated.

Changing the user

A different user can log on without closing the Qognify VMS client.

1. Select Change user from the File menu, and select the user.

2. Click OK to confirm your selection. The current user is logged out, and the new

user has to log in with a user name and password (see "Login" on page 7).

Alternatively, the user can also be changed via the user icon in the function bar (see
"Changing the user" on page 76).

Switching Qognify VMS installation

If you have installed multiple independent Qognify servers, you can connect to a dif-
ferent Qognify server.

1. Choose Switch installation from the File menu. The login screen is displayed

(see "Login" on page 7).

2. Enter the server name or IP address and the user name and password. The cur-

rent installation is terminated, and the selected installation is started.

Installation manager

The installation manager manages and defines connections to multiple installations
(CoreServers). The current connection status is displayed.
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Connecting to multiple installations can result in huge client and network load.

When using bandwidth optimized archive playback from multiple installations,
make sure all installations are appropriately configured (see Bandwidth optim-
ization).

Fig. 19: Installation manager

n Autoconnect: Activates or deactivates the client to connect to the selected install-

ation automatically.
n Search: Searches for available installations

n New ( ): Adding a new installation

n Delete ( ): Removes the installation from the list

1. To edit a connection, click on the respective installation name.

2. To add an installation, select New ( ) and edit the connection. The new install-

ation is not connected automatically.

3. To connect an available installation, enable Autoconnect.

Requirements

n The server version on all servers to which a connection will be established

cannot be higher (newer) than the client.

The user interface

The function bar
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n All servers must support multi-installation login. A license must be available

for Qognify multi-installation login.

Add an installation

1. Select Installation manager from the File menu, and select the desired serv-

ers.

2. If the server is not displayed, add the installation by entering the installation

name, the IP address or host name, and the port number of the server.

3. Click Add.

Reorder installations

Fig. 20: Reorder installations

1. Reorder the list of installations by selecting one object and dragging it to the

designated place in the list.

Disconnect and reconnect a Qognify installation

The color marker in the symbol indicates the connection state: a green dot indic-
ates a connected system and red dot stands for disconnected.

1. Click Autoconnect to connect the client to the selected server automatically

when starting the client.

2. For manual connecting or disconnecting, click Connect or Disconnect.
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3. To login to all installations with the same user name and password, select

Use local credentials for all installations. Optionally this option can be activ-

ated on the login window (see "Advanced login options" on page 11).

In this case make sure that the remote users are the same as the local cre-
dentials.

Edit Qognify installations

Changes the IP address, host name and the port number of the selected server.

1. Click Edit at the Qognify installation that you want to change. The selec-

ted server is displayed at the bottom of the window.

2. Edit the installation name, the IP address or host name, and the port number

of the server.

3. Click Apply.

Delete saved Qognify installations

Tidies up the list of Qognify installations most recently called by the client (see
"Login" on page 7).

1. Click Delete at the Qognify installation that you no longer want to be

available for selection.

2. To delete multiple installations at once, select the installations you want to

delete and click Delete selected objects.

View

The menu view displays the following options:

n Adding a window
n Adding sequential alarm window
n Keep the aspect ratio
n Borderless display

The user interface

The function bar
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n DisplayAgent
n Video wall dispatcher
n LPR master data editor
n Count analysis
n Access control data editor

The settings made in the View menu are stored locally and have to be made on
each client and for each Windows® login profile individually.

Exceptions are:

n Settings for the "LPR master data editor" on page 40
n Count analysis data

These data are saved on the server(s) by their corresponding services.

Adding a window

This function allows you to distribute the display of the work area to multiple con-
nected monitors.

1. Choose Add window from the View menu. A second window opens.

2. Move the window to the connected monitor. The client saves the setting and

makes it available when you log in again.

3. To use multiple connected monitors, repeat these steps.

Adding a sequential alarm window

In case of an alarm scenario, cameras that are defined as alarm cameras in an act-
ive alarm scenario are displayed in a separate alarm window. The name of the
camera is displayed and the color of the image frame in the window corresponds to
the color of the alarm scenario.

38 / 144



Fig. 21: Adding a sequential alarm window

1. Select Add sequential alarm window to display all alarm related cameras in

a new dedicated window.

2. Select one of the following options:

n Row mode to display images with one alarm per row

n Continuous mode to display multiple alarms per row

Keeping the aspect ratio

1. Select Keep aspect ratio to adapt the camera image to the layer window.

The camera image may appear distorted.

2. Deselect Keep aspect ratio to display the camera image with the original

aspect ratio.

Borderless display

1. Select Borderless display to hide the controls and the bars between the

camera images in layers with multiple cameras. If a camera is selected, the

border will be displayed.

2. Deselect Borderless display to hide the controls and the bars between the

camera images in layers with multiple cameras.

The user interface

The function bar
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DisplayAgent

The Qognify DisplayAgent allows you to use standard PCs and monitors to create
a full-fledged remote-controlled video wall controlled by the video wall dispatcher.

A video wall dispatcher is required to control a DisplayAgent.

Video wall dispatcher

The video wall dispatcher can control associated monitors dynamically. You can
drag and drop camera images, layers, maps and web pages to display them on
video walls, e. g. Qognify Display Agents or eyevis video walls.

LPR master data editor

In the LPR (license plate recognition) master data editor you can add and delete
license plates, as well as edit related data like driver's name, tickets, history and noti-
fications.

The license plate recognition must be configured in the Qognify VA Admin-
istration Tool prior to usage.

The LPR master data editor is only available when at least one LPR group with
the appropriate rights has been configured.

Fig. 22: LPR master data editor

To manage license plates, the following options are available:
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Creating a new license plate

Depending on the configuration, the window for entering new data is opened auto-
matically as soon as a license plate is recognized by the camera.

You can start the LPR master data editor from the "View" menu.

Fig. 23: Creating a new license plate

1. Select New in the master data editor.

2. Enter the new license plate in the text box in the upper left if it is not yet dis-

played.

3. Select the tab License plate groups and assign the license plate to one or

more license plate groups. License plate groups are created in configuration

mode in the license plate groups area.

4. Optionally, add descriptions for the license plate. The names and number of

text fields are defined in the server area in configuration mode.

5. Select OK to apply the settings.

Editing a license plate

1. Select a license plate in the list of the master data editor.

2. Select Edit to change the details for the license plate.

The user interface

The function bar
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LPR master data

Fig. 24: LPR master data

1. Edit the license plate, the driver's name and the vehicle model.

2. Select OK to apply the settings.

License plate groups

License plate groups define the affiliation of a license plate to one or more
groups.

Fig. 25: Ticket

1. Assign the group or groups to which the selected license plate belongs.

2. Select OK to apply the settings.
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Ticket

Tickets define the validity time periods for certain licenses, e. g. a license plate
is allowed to pass a barrier at office time only.

Fig. 26: Ticket

1. Select a predefined Validity period for the license plate. The predefined

validity periods are displayed on the left.

2. To enter a specific time period, click Activate and enter the desired time

period. The status of the ticket is indicated in the LPR list by a different

font color and an icon. If a period is already defined, activation is no

longer enabled.

3. Select OK to apply the settings.

The user interface

The function bar
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Email notification

You can send email notifications to certain recipients as soon as the vehicle
with the specific license number is recognized.

Fig. 27: Email notification

1. Enter the email addresses of the recipients separated by semicolons.

2. Enter the text for the email body. The numbers on the right are place-

holders for variables (i.e. license plate details) that are sent auto-

matically.

3. Select OK to apply the settings.

Example: The text in the message "License plate [1] was recognized [4] at [5]."
is sent as "License plate LU CY 8000 was recognized 15.04.2010 at 4:25 pm."
in the email.

Deleting a license plate

1. Select a license plate from the list.

2. Select Delete to remove the selected license plate from the list.

3. Acknowledge the deletion. The license plate is removed from the database.
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Displaying only license plates of a selected group

1. Select Change view and select the license plate group.

2. To see all license plates, select Change view and select All.

Displaying license plate groups

License plates in the list can be sorted and displayed by license plate groups.

1. Select Change view to display only the license plates belonging to the

selected group.

2. Click the arrow beside the name of the license plate group to close it.

3. Click the arrow again to open the license plate group again.

Refreshing the view

1. Select Refresh view to refresh the data by updating the data from the

server.

Searching for a license plate

1. To search for a license plate in the list, enter part of the master data set of

the license plate into the Search . The search is started automatically,

and the result is displayed in the list.

2. Click the X in the search to clear the search.

3. When the configured maximum number of search results is exceeded, the

result can be exported as a CSV file.

Exporting license plate master data

You can export the master data of selected license plates as a *.CSV file (a text file
with values separated by semicolons) in order to analyze or prepare it for further
import into databases.

The user interface
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1. Select the license plate whose master data you wish to export. To export mul-

tiple license plates, select the license plates while pressing and holding the

CTRL key.

2. Select Export to export the master data as a CSV file (see "Data fields

for export and import" below).

Importing license plate master data

You can import the master data of license plates from a *.CSV file (a text file with
values separated by semicolons) .

1. Select Import  and select a CSV file with the license plate master data to

be imported (see "Data fields for export and import" below).

Data fields for export and import

The export and import file must contain the following data fields:

LicencePlate;reserved;Group;;;;;;;;;;;AlwaysValid;ValidFrom;

ValidTill;Email;EmailText;TimePattern;modify

Field name Value Note

LicensePlate The license plate

reserved

Group Text Name of license plate group as
configured
If there is no entry the group will
be defined as "unknown"

; Text Placeholders for user-defined
master data fields

ValidFrom Date-time value Datetime in the format yyyy-MM-
dd HH:mm:ss (for example
2021-01-15 23:59:59)

ValidTill Date-time value Datetime in the format yyyy-MM-
dd HH:mm:ss (for example
2021-01-15 23:59:59)
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Field name Value Note

AlwaysValid 1 "always valid" (same values in

fields ValidFrom and ValidTill

0 different values in fields

ValidFrom and ValidTill

ValidityName negative value, e.g. -1 Always

positive value ID of related time template

Modify n "0": Modify existing license

plate information like group,

custom fields etc.
n "1": Add a new license plate

into the database.
n "-1": Removes the selected

license plate information

from the editor but does not

delete the item in the data-

base.
n "2": Import or export the

membership of an additional

group of a license plate. For

more groups to import or

export, add as many lines as

needed.

Value change is possible (see
"Importing license plate master
data" on the previous page).

All fields except for
"modify", "LicencePlate",
and "Group" are ignored if
"modify" is set to "2".

Example:
LicencePlate;reserved;Group;;;;;;;;;;;AlwaysValid;ValidFrom;ValidTill;Email;
EmailText;TimePattern;modify
QV MS 8285;;unknown;;;;;;;;;;;1;2024-12-01 02:55:30;2024-12-01 02:55:30;;;-1;0
QV MS 8286;;test;;;;;;;;;;;1;2024-11-30 02:55:30;2024-11-01 12:55:30;;;-1;1
QV MS 8287;;test;;;;;;;;;;;1;2024-10-31 09:29:59;2024-10-01 23:55:00;;;-1;-1

Tools

This menu displays the following options:

The user interface
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n Multiple export of image data (see "Multiple export of image data" on page 56)
n Write protection of recordings (see "Removing write protection from recordings

of multiple cameras" on page 62)
n Configure logo action (see "Configuring a logo action" on page 63)
n Status report for automatic image export (see Status report for automatic image

export)
n Manual reference image comparison (see "Manual reference image com-

parison" on page 64)

The Export Designer

The Export Designer in Qognify VMS configures the image export, i.e. adding shapes
to hide specific areas of the exported images to increase privacy or defining a time
range.

Creating a new export

Fig. 28: The Export designer
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Defining the image or image sequence

1. In the Tools menu, select Create New in the Export Designer.

2. Select a camera from the list or search for a camera in the search box

above the list.

3. Move the timeline to the desired position. The corresponding frame is

displayed. Zoom in or out of the timeline using the scroll wheel of the

mouse for more detail.

4. Select Add sequence to set the time range of an image sequence

export.

5. Drag the handle of the sequence delimiter to the right. This defines the

time range for the export. Images within that range can be exported.

6. To mark only a single image for the export, select Add single image

and drag the marker to the position on the timeline.

Viewing privacy masks

To determine if privacy masks are used in an image, a privacy mask can be
highlighted in the preview window before exporting.

Without permission to hide privacy masks (or in offline mode), the but-
ton is deactivated and privacy masks are always shown and exported.

1. To highlight a privacy mask in the image, select Mask  in the Tools

menu. All privacy masks of the current image in the preview window are

displayed.

2. Before exporting a file with privacy mask disabled or enabled, toggle the

Mask for a selected camera in the list on or off (for exporting, refer

to "Defining the export settings" on page 51).

Adding shapes

Areas of the image or image sequence can be hidden in the export to prevent
information from being displayed in the export result, e.g. license plates or pri-
vacy sensitive objects.

The user interface

The function bar
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Fig. 29: Adding shapes in the Export designer

1. To add a shape, open Shapes in the toolbar on the right and select a

shape. The selected shape is placed in the top left corner.

2. Drag the shape onto the image or sequence and resize.

3. Define the background color and transparency as well as the border

color and transparency.

4. Move the shape icon on the timeline to define the object to be masked

within the time range.

5. To delete a shape from the image, select Delete next to the shape

in the list of “Current shapes”.

6. To delete a keyframe, select Delete keyframe next to the keyframe in

the list of “Keyframes”.

Adding a mask with "Click2Mask"

To confirm with privacy protection, persons in a scene can be masked auto-
matically before exporting. This feature is called “Click2Mask”.

To use "Click2Mask", the BVI server module must be installed. This fea-
ture requires 64bit mode and cannot be used with the package Qognify
VMS S50.
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1. To add a mask, select a camera and add an image sequence.

2. Open Shapes in the toolbar on the right and select Analyze .

Qognify VMS analyzes the sequence for a person. The resulting

sequence is displayed in the section "Keyframes".

3. If necessary, adjust the shape.

Defining the export settings

For security reasons, not all users are permitted to directly export image data.
For users with limited export permissions, the selected export files are col-
lected in virtual "basket" as export preparation.

1. To enable the export preparation, move the slider to the right.

n When disabled, the files can be directly exported by the user.
n When enabled, the files are saved on the server as "prepared exports"

and can only be exported by a user with sufficient user rights.

2. To define the export settings such as a password protection, open

Export settings in the toolbar on the right.

3. Enable the display of the camera time as additional information in the

image.

The user interface
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4. Enable password protection if required, and set either a domain default

password or a user specific password.

If password protection is enabled for the profile by default, it can

only be disabled by the administrator.

5. Click the folder icon and select the export location of the file.

6. To add a variable to the export file name, click (x) and select the vari-

able. You can insert variables that will be included in the file name at the

time of export, such as:

— Insert a variable for camera name: The name of the selected cam-

era is included in the exported file name.
— Insert a variable for export time: The time of the export is auto-

matically included in the file name and can be defined by a

timestamp, the date, day, time, etc.
— GUID: The global unique identifier of the file is included in the file

name.

7. Save the export settings.

8. Select Start export or select Save prepared export, if export pre-

paration has been enabled.

n When Start export has been selected, the exporting progress is dis-

played.
n When Save prepared export has been selected, the files are stored on

the server in the export preparation queue

9. Open the Export Manager to open the exported file.

Resuming the export

Exports are queued in the Export Designer. The export settings can be restored in
case of failure. The settings file that has previously been configured in the export
designer is reloaded into the export queue.
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1. In the Tools menu, select Resume in the Export Designer.

2. Optionally, delete or open and reconfigure the export settings.

3. Start the export.

Opening the prepared exports

Prepared exports that have been configured and saved can be loaded into the
Export Designer without the need to reconfigure. The setting will replace the cur-
rent configuration in the queue.

1. In the Tools menu, select Load in the Export Designer. Only prepared

exports are displayed that the current user has access to.

2. Optionally, delete or open and reconfigure the export settings.

3. Start the export.

Sharing a camera

Apart from a user with administrative rights, any user can share a camera if the user
rights are set.

If a sharing or receiving party is deleted or deactivated, or loses the sharing or live
view rights while sharing cameras, the sharing is stopped.

The user interface
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Fig. 30: Sharing a camera

Start sharing a camera

1. In Surveillance mode, open the camera in the work area.

2. Select Share manager > Start sharing from the Tools menu.

3. Select the user or group.

4. Click OK to confirm.

Stop sharing a camera

1. In Surveillance mode, open the camera in the work area.

2. Select Share manager > Stop sharing from the Tools menu.

Restriction manager

A user or group can temporarily be restricted from accessing cameras with the "Restric-
tion manager". This can be required to limit access for users or groups that are nor-
mally allowed to view images by restricting access to image data exposing sensitive
private data (e.g. accidents) for a certain period.

Restricting the view of image data to other users requires the appropriate per-
missions.
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Known limitations

n If a user or group restricting other users or groups is deleted the restrictions

remain.
n If a user or group restricting other users or groups is deactivated the restric-

tions remain.
n If a user has permissions from multiple groups and one group is restricted,

the user will be restricted as well.
n An administrator can be restricted, but may undo his restrictions.
n Restriction takes precedence over sharing, i.e. a restricted image cannot be

seen when restricted for the user or group.
n A user or group can restrict itself.
n If a user is allowed to configure a camera, but is restricted, the user is still

able to configure the camera but cannot see a video.

Restricting a camera

1. In Surveillance mode, select Restrict manager > Start restricting from the

Tools menu. All cameras in the active layer are pre-selected.

The user interface
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2. Define the restriction starting and stopping time.

n If the time interval is set in the past, the user still can access the image in

Surveillance mode, but will not be able to see it in Archive mode.
n If the time interval is set in the future, the user will neither see the image in

Surveillance mode nor in Archive mode.

3. If required, set the restriction interval before and after the restriction period.

4. Select the camera(s) to be restricted.

5. Select the users that should be banned from access.

6. Select OK.

Editing restrictions

1. Select Restrict manager > Edit restrictions from the Tools menu.

2. Select Currently active to display only the currently active restrictions.

3. Select the restriction and select Edit .

4. Define the start and end times of the restriction and click OK.

Multiple export of image data

Image data can be exported with two different processes:

n Using “Multiple export of image data” in surveillance mode.
n Exporting video from the opened tiles in archive mode (see "Exporting record-

ings" on page 119).
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When exporting video recordings, the exported data are saved in encrypted form and
can then be played back on a computer without a Qognify installation with the Qognify
viewer. The Qognify viewer is found in the export directory.
The setup files for the Qognify Viewer and the burning tool for burning the exported
video material onto a storage medium can also be found in the folder "Tools" of the
Qognify installation (see "Anywhere Viewer" on page 139).

During the export process, the Qognify viewer installation file is copied to the

export folder as well. This allows the files to be run on a computer without a

Qognify VMS installation with only the Qognify viewer installed. The Qognify

viewer will import the files and display them as separate time intervals.

1. Select Multiple export of image data from the Tools menu.

2. Select one of the following options.

AVI export to the client

Fig. 31: AVI export of image data

1. Make sure that a temporary folder for image data export to the client is con-

figured and available.

2. To open or close the list, select Expand/collapse all .

3. Drag and drop the cameras for export into the right column. For each cam-

era, all marked time spans are displayed.

4. To delete a time span, select Delete selected items in the cor-

responding row.

5. Specify if the image data is exported with or without privacy masks.

Exporting without privacy masks can lead to a breach of privacy laws.
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6. To store the exported image data in separate folders by user, camera name

and time of export, select Create subfolders for user, camera name and

time of export.

7. Select the video compression format:

— Qognify Encoder
— DV Video Encoder
— MJPEG compressor
— Source format

8. Specify if only i-Frames should be exported.

9. Enable Audio if the video source contains audio channels that should be

included in the export.

10. To carry out the export immediately, click Export. The settings are saved

after export or by closing the window.

The filename of the AVI file has following format:
<camera name>_<fromDate>-<fromTime>_<toDate>-<toTime>.avi
The name cannot be changed. If the name already exists, a sequential num-
ber is automatically appended.

JPEG export to the client

Fig. 32: JPEG export of image data

1. Make sure that a temporary folder for image data export to the client is con-

figured and available.
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2. To open or close the list, select Expand/collapse all .

3. Drag and drop the cameras for export into the right column. For each cam-

era, all marked time spans are displayed.

4. To delete a time span, select Delete selected items in the cor-

responding row.

5. Specify if the image data is exported with or without privacy masks.

Exporting without privacy masks can lead to a breach of privacy laws.

6. To store the exported image data in separate folders by user, camera name

and time of export, select Create subfolders for user, camera name and

time of export.

7. Specify if only i-Frames should be exported.

8. To specify the number of exported frames, enable Limit frame rate and spe-

cify the number of images per second of video stream (default is 25 fps).

9. To carry out the export immediately, click Export. The settings are saved

after export or by closing the window.

Export of native data to the client

Fig. 33: Export of native image data to the client
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1. Make sure that a temporary folder for image data export to the client is con-

figured and available.

During export, the exported image data from the failover server are

transmitted to the production server. Make sure the production server

provides enough storage space.

2. To open or close the list, select Expand/collapse all .

3. Drag and drop the cameras for export into the right column. For each cam-

era, all marked time spans are displayed.

4. To delete a time span, select Delete selected items in the cor-

responding row.

5. Specify if the image data is exported with or without privacy masks.

Exporting without privacy masks can lead to a breach of privacy laws.

6. To store the exported image data in separate folders by user, camera name

and time of export, select Create subfolders for user, camera name and

time of export.

7. To secure the exported image data using the default password, select Use

default password.

This option is disabled when the usage of the default password is

enforced in the profile settings in configuration mode.

8. If you want to use your own password instead of the default password, enter

this password and repeat it. The default password is set in configuration

mode in the DeviceManager (DM) section.

9. Specify if only standard recordings should be exported or if alarm record-

ings should be exported as well.

10. To store the exported image data in folders of approximately the same size

as the expected file size, select Split export into multiple folders and spe-

cify the folder size and maximum size of the image file. Image data that

exceeds the specified size is split into multiple files so that they can be

stored on data carriers such as CD-ROMs or DVDs.

11. If the image data is to be exported to a client that has only a low-bandwidth

connection, select Use bandwidth limit and specify the bandwidth limit.

12. To carry out the export immediately, click Export. The settings are saved

after export or by closing the window.
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Exporting native image data to the server

Fig. 34: Exporting native image data to the server

1. Make sure that a temporary folder for image data export to the server is con-

figured and available.

During export, the exported image data from the failover server are

transmitted to the production server. Make sure the production server

provides enough storage space.

2. To open or close the list, select Expand/collapse all .

3. Drag and drop the cameras for export into the right column. For each cam-

era, all marked time spans are displayed.

4. To delete a time span, select Delete selected items in the cor-

responding row.

5. Specify if the image data is exported with or without privacy masks.

Exporting without privacy masks can lead to a breach of privacy laws.

6. To store the exported image data in separate folders by user, camera name

and time of export, select Create subfolders for user, camera name and

time of export.

7. To secure the exported image data using the default password, select Use

default password.

8. If you want to use your own password instead of the default password, enter

this password and repeat it. Optionally, use the default password. The

default password is set in configuration mode in the DeviceManager (DM)

section.
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9. Specify whether only standard recordings are to be exported or whether

alarm recordings are to be exported as well.

10. To split the exported files for storage on multiple data carriers such as CD-

ROMs or DVDs, select Split export into multiple folders.

The minimum size of the file is 100 MB.

11. Select the desired folder size according to the export medium (e.g. CD,

DVD, Blue-ray disc).

12. Specify the maximum size of the image file.

13. To carry out the export at a specific time, select Select time for export, and

then specify a date and time for the export.

14. Specify the date/time period for the image data to be exported.

15. Click Select and specify the location of the exported image data.

During export, the exported image data from the failover server are

transmitted to the production server. Make sure the production server

provides enough storage space.

16. To carry out the export immediately, click Export. The settings are saved

after export or by closing the window.

Viewing exported files

n For viewing the exported files, use the “VMS_PortableViewer”. The Viewer

allows opening an viewing the exported files without modification and

without installation of Qognify VMS.
n Optionally, use the offline mode of the Qognify VMS client.

Removing write protection from recordings of multiple cam-

eras

The write protection of recorded image data can be deleted (see "Write protection" on
page 121).
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Fig. 35: Removing write protection from recordings of multiple cameras

1. Choose Write protection of recordings from the Tools menu.

2. Select the cameras to be checked to make sure whether there is a write-pro-

tected recording area.

3. Click Start query to display any write-protected recordings of the selected cam-

eras.

4. Select the areas in which write protection is to be removed from recordings.

5. Select Remove write protection.

6. Close the window.

Configuring a logo action

Logo action allows you to specify which layer is to be displayed when you click the
Qognify logo at the top of the screen.

The user interface

The function bar
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The user interface

The function bar

Fig. 36: Configuring a logo action

1. Select Configure logo action from the Tools menu.

2. Select the defined layers from the drop-down list. The layers are saved in the con-

figuration menu.

3. Click OK to confirm.

Manual reference image comparison

To create reference camera images and compare camera images, the user
must have the rights to see live images in surveillance mode.

Fig. 37: Manual reference image comparison

The manual reference image comparison helps detect changes in the static object.

Mobotix cameras are only supported for Motion JPEG. Reference Image com-
parison does not work on images from fish-eye cameras.
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1. Select a camera from the list and click Create reference image. The current cam-

era image will be used as reference image. The current view displays the actual

live image of the camera or an archived image.

2. To delete a reference image, select the camera from the list and click Delete ref-

erence image.

3. Select the camera and check both images for changes.

4. Select Deviations (2) to reject and mark the images as not identical. The red icon

(7) is displayed behind the camera name.

5. Select Congruence (4) to accept mark the images as identical. The green icon

(6) is displayed behind the camera name.

6. If the changes are difficult to see, select Show differences only. The changes

detected by the image processing software will be displayed as highlighted areas

in the current view. If no changes are detected, the current view turns black.

7. Deselect Show differences only to return to the actual camera image.

8. Select Activate computerized support to display a threshold scale. Move the

pointer on the scale to change the threshold values. This changes the threshold

values of the current image and helps discern possible changes in the image.

9. Select Live mode or Archive mode. When Archive mode is selected, the ref-

erence image can be compared to a recorded image.

10. Select Calendar (5) and select a date and time of the archived image.

11. To print a report of the results, select Print (3).

Printing the reference image comparison report

Fig. 38: Printing the reference image comparison report

The user interface

The function bar
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The user interface

The function bar

1. In Settings, the print options can be specified:

— Select Show difference images to print the current views with the dif-

ferences highlighted.
— Select Show difference as percent to print the percentage of the detec-

ted differences within each image.
— Select Show rejected cameras only to print the report without the

accepted cameras.

2. Enter the User name and add a Comment, if necessary.

3. Select Print report.

Info

The menu Info displays information about the system and both procedures to obtain a
license for Qognify VMS 7.5. The installation must be activated within 30 days. This
requires sending an automatically generated activation key, the product ID, to Qognify.
This menu displays the following options:

n Activating the software
n Showing information about the software

Activate the Qognify VMS license online

The product is activated online to personalize a license or download a license file.

Online activation requires a connection to the internet.
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Personalize a license

Fig. 39: Personalize a license

1. In the Info menu, select Activate product.

2. Select Online.

3. Select Personalize license if you want to register it with your user data, and the

license has not yet been registered.

4. Enter your installation number (INR) and user details.

5. Click OK to confirm your entries. The client connects to the Qognify registration

server and transfers the license key to the computer.

The user interface

The function bar
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The function bar

Download a license

You can download a new license file if an update has been carried out and the license
is required again.

Fig. 40: Download a license

1. Select Download license.

2. Enter your installation number (INR).

3. Click OK to confirm your entries. The client connects to the Qognify registration

server and transfers the license key to the computer.

If the product ID has changed (e.g. due to changes to the server hardware), con-
tact the Qognify support.
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Activate the product offline

If the client has no internet access, activate the client by first applying for a license via
email. After receiving the license file per email, it has to be imported.

Applying for a license

Fig. 41: Applying for a license

1. In the Info menu, select Activate Product.

2. Select Offline.

3. Select the tab Product ID. The software creates a unique product ID.

4. Click Copy to copy the displayed product ID to the clipboard.

5. Open the Qognify website and navigate to "Support" and "Licensing".

6. Select "New license code".

7. Enter your product ID and the other information requested there. You will receive

the license file by email.

The user interface

The function bar
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The user interface

The function bar

Importing a license file

Fig. 42: Importing a license file

1. In the Info menu, select Activate Product.

2. Select Offline.

3. Select the tab Import license file.

4. Click Select and navigate to the storage location of the license file.

5. Select the license file. Upon import, the zipped file will be decompressed auto-

matically.

6. Click Import to use the license key.

Show license

A test license will be installed during installation and is valid for 30 days. A
demo license is valid until the displayed date. If no valid license is available,
login is not possible. For further questions, contact the Qognify support.

1. In the Info menu, select Show information.

2. Select Show license. Information on the license is displayed in three tabs.

3. Select tab Overview to see general information of the product, e.g. the INR

(Installation Number), SMA (Software Maintenance Agreement), the validity

period of the license (if it is a demo license).
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Fig. 43: Show license - overview

4. Select Features to see the features activated by the installed license file.

Fig. 44: Show license - features

5. Select Modules to see how many modules like cameras (devices), servers, ana-

lytics channels etc. are activated by the installed license file.

The user interface

The function bar
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Fig. 45: Show license - modules
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Show program information

Fig. 46: Show program information

1. Select Show program information from the Info menu. The information on items

such as the program version, current user and profile and also validity of pass-

word is displayed.

The user interface

The function bar
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Show system information

Fig. 47: Show system information

1. Choose Show system information from the Info menu. The information on items

such as the Core Service Main, the numbers of activated DeviceManagers, video

sources (cameras) is shown.

2. Click Copy to copy the system information to the clipboard. You can paste the

data from the clipboard to your email program to send it to support.
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Help

The help menu displays the following options:

Online help

Starts the help system on the starting page. In addition, there are also links for
accessing specific topics directly from the various controls and dialog boxes. The
system automatically checks for current versions of the online help system. The
user is notified if the installed version is not up-to-date.

When starting the help system for the first time, you may be prompted by
the browser to activate ActiveX or allow JavaScript. The help system will
not function properly, if those services are blocked.

Start problem recording

If problems occur during operation, you can use the "Start problem recording" func-
tion to record, comment on and save them. The "Problem Steps Recorder" is part
of the operating system.

1. Select Start problem recording from the Help menu.

2. Select Start recording and carry out the steps that led to the problem.

3. As soon as you have carried out these steps, stop recording.

4. If you want to add a comment to the recording, click Add comment (e.g. the

time, behavior of the client and devices, etc.).

5. Specify where the file is stored.

Display help icons

1. The help icons are small gray circles with question marks in the program

components that lead directly to the applicable section of the Online help sys-

tem.

2. Enable or disable Display Help icons from the Help menu.

The user interface

The function bar
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The mode bar

Changing the user

The user interface displays the current user in the function bar.

Fig. 48: Changing the user

1. Click the user icon in the function bar.

2. Click Change user to log on to the server as another user. Alternatively, change

the user via the "File" menu (see "Changing the user" on page 34).

3. Click Log out to log out the current user from the server.

The mode bar

Fig. 49: The mode bar

The mode bar allows you to switch between display modes.
n Surveillance mode (1). After login, the system starts up in

surveillance mode (see "Surveillance mode" on page 79).

The number of alarms and system events that have

occurred are indicated by a number in the icon. Addi-

tionally, the number of alarms and system events are indic-

ated by a number in their respective tab in the alarm list

(see "Alarm list and system messages" on page 106).
n Archive mode (2): Archive mode manages and displays

recorded image data and search for alarm events (see

"Archive mode" on page 111). The number of export oper-

ations that have occurred is indicated by a number in the

Archive icon.
n Report mode (3). Report mode displays a list of the events

that have occurred (see "Report mode" on page 133).
n Configuration mode (4). Configuration mode manages

and configures the video sources, users and locations.
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n LPR mode (5). LPR mode is used for license plate recog-

nition in the image data of the corresponding cameras.

The control bar

The control bar contains the tabs required, depending on the mode, for controlling the
display or for configuration. You will find descriptions of the tabs in the sections describ-
ing each mode. Tabs cannot be moved. They remain anchored in position on the con-
trol bar.

Displaying items in tree view

1. Click on the left side of the upper item in the tab to display or hide the

items beneath.

Opening the context sensitive help

1. Click Help to open the online help in the default web browser. The web

browser can be selected in the client configuration (see "Client con-

figuration" on page 16). The online help can also be started from the help

menu (see "Help" on page 75).

Pinning the control bar

By default the control bar is always visible (pinned). An auto hide option is avail-
able.

n Select the pin to activate the auto hide function. In this state the control

bar minimizes automatically to the right when the cursor moves away from

the control bar. As soon as the cursor moves over the minimized control bar

it appears automatically.

The user interface

The control bar
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Search

n Select the pin again to deactivate the auto hide function. In this state

the control bar is always visible (default).

Minimizing and maximizing a control

n Click the double triangle to minimize a control to the top of the control

bar.

n Click the double triangle to maximize a control.

Minimizing and maximizing the control bar

n Click the gray triangle in the upper-right corner

of a control to minimize the control bar to the right. The

size of the main window increases.

n Click a gray triangle on the minimized control bar to maximize the con-

trol bar.

Search

Qognify VMS provides mode-specific search and query functions:

n Searching in surveillance mode (see "Searching in surveillance mode" on

page 109)

Searching for items in the control bar is also available in Archive mode

and LPR mode.

n Searching for alarms in archive mode (see "Searching for alarms" on page 123)
n Searching (query) in report mode (see "Filtering the query" on page 134)
n Searching in configuration mode
n Searching (query) in LPR mode
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Surveillance mode

Surveillance mode allows live images, web sites, maps, layers, alarms and patrols to
be displayed and PTZ cameras and other peripherals, such as door openers, that are
to be controlled (see "The user interface" on page 13).

1. To change to Surveillance mode, click Surveillance mode on the mode bar.

Camera operation

You can handle the functions of the camera using the control bar (see "Camera
image controller" on page 88) or using the Control (see "Camera control" on
page 97).
To operate a camera, select the camera in the work area.
You can recognize a standard recording by a green dot below the lower right edge
of the camera image in surveillance mode. You can recognize an alarm recording
by a red dot below the lower right edge of the camera image.
If there is no recording, a black square instead a red or green dot is displayed.

4



Surveillance mode

Work area

Tabs

The tabs allow you to open and close the layers (see "Work area" below).

Control bar

The control bar allows you to perform the following actions:

n Move the selected PTZ cameras and change the image detail (see "PTZ con-

trol" on page 97)
n Perform actions using buttons (see "Buttons" on page 101)
n Carry out patrols (see "Patrol" on page 101)
n Use the optionally installed communication options (camera and audio) (see

"Audio" on page 102).
n Call dispatcher mode (if installed, see "Video wall dispatcher" on page 40).

The dispatcher mode is switched on and off via the View menu.
n Select the cameras created for each location (see "Overview" on page 96)
n Search for specific installed cameras

Work area

The work area is the main window for displaying tiles with items such as camera
images, patrols, or maps (see "The user interface" on page 13). The work area displays
up to 100 tiles at the same time. The tiles can be arranged in different ways:

n Evenly as a grid
n With a main tile and smaller tiles

The name of the user of the camera is displayed in the top part of the image to
all watchers, if configured.
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Alarm notification ("Toast notification")

Fig. 50: Alarm notification ("Toast notification")

Depending on the setting, alarms and system messages are displayed as they
occur in a separate message window (alarm notification) at the bottom of the
screen. For further information, see the "Alarm messages" on page 106.

Creating layers and adding objects

Layers can be set in the layer area in configuration mode. Temporary layers, which
are only available for the user and are not saved, can optionally be combined.
In some layers, the available objects such as cameras or maps can be assigned to
any tile in the work area.

1. Drag the desired layer from the Overview control to the work area..

2. Optionally, click Layer menu on the function bar (see "The function bar" on

page 15) and select Add layer. You can select the desired number of tiles or

create a user-defined layer. Or select Load personal layer to load a pre-

vious saved user defined layer. The selected layer is displayed right to the

layer menu icon in the tab selector.

3. Drag the selected object from the overview panel to the desired empty tile in

the work area. To move an object in the work area, drag it to the tile in which

it is to be displayed. If there is an object there already, it is moved to the pre-

vious tile of the moved object.

4. Click the cross on the tab bar to close the layer.

5. Select Open layer in secondary window to display the new layer on a

second screen (see "View" on page 37).

Surveillance mode

Work area
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Surveillance mode

Work area

6. Select automatic layer switching and the desired interval to switch auto-

matically between the opened layers after a certain interval.

Automatic layer switching is stopped in the event of an alarm scenario and

automatically resumed after an alarm.

Minimizing the display space for audio-only sources

A source may provide only audio input but requires the space of a whole tile. The
required space can be reduced to a bar at the bottom of the layer view.

Up to four audio-only sources can be minimized.

1. Select the audio-only source and drag it to an empty tile in the layer.

2. Select the audio mode icon and select "Audio only". The tile is reduced

to a bar and displays only the following functions:

n Layer options
n Audio
n Open tile in 1x1 layer
n Start alarm recording

3. To expand the object, drag it to an empty tile.

Setting the viewing mode on multiple windows

The viewing mode feature is available when using multiple client window to keep
the windows in different states. If multiple displays are connected to the client, cli-
ent windows can be distributed to them. The viewing mode of each window can be
set separately, so displays can remain in surveillance mode even if the main dis-
play is switched to another mode (e.g. archive mode or configuration mode).

Fig. 51: Viewing mode icon "Keep window in surveillance mode"

1. Switch to surveillance or archive mode and drag the required camera view

onto the secondary window. The drag & drop feature works between sur-

veillance and archive mode and vice versa.
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2. On the secondary window, select Keep window in surveillance mode (

). The camera view on the secondary window will remain in surveillance

mode with live image even if the primary window is switched to another

mode.

3. To remove the viewing mode on the secondary display, select the monitor

icon again.

4. When clicking on the monitor icon on the secondary window after switching

the viewing mode on the primary window, the last live image view will be

restored on the secondary window.

Sequential alarm window

The settings for the sequential alarm window are defined in the View menu (see
"Adding a sequential alarm window" on page 39).

Fig. 52: Sequential alarm window

1. To switch to the sequential mode, select Row mode ( ). The alarms will be

displayed in a single row. If the number of alarm cameras exceeds the number of

columns defined, the remaining alarm cameras will be ignored.

2. To switch to Continuous mode, select . If the number of alarm cameras

exceeds the number of columns defined, the additional cameras will be added in

the row below.

Click-2-Track

A person or object that moves across different camera views can be followed even
without specifying the camera name of the following view. Instead, the person or object
path is defined in surveillance mode by activating the area covered by the adjacent
camera.
This feature is also available in archive mode (see "Click-2-Track" on page 115) and
can be invoked with the mini archive player (see "Mini archive player" on page 91).

Surveillance mode

Sequential alarm window
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Surveillance mode

Click-2-Track

This feature requires an appropriate license and is not included in the standard
package.

Fig. 53: Click-2-Track in surveillance mode

1. To start Click-2-Track, select the tile and click on the camera options.

2. Select Activate.

3. Select the region on the image where the person or object moves to. The linked

camera image is displayed in the preview inset.

4. To bring the image in the inset into the tile, click on the preview. Click-2-Track

remains activated.

History

Once multiple camera regions have been visited, the history buttons are active. They
are used to navigate forward and backward through the history of this tile, since each
tile has a separate history.
When using the Click-2-Track history in surveillance mode, the tile is switched to mini
archive player.

Preview cameras shown while in mini archive mode display the same time as
the mini archive player.
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Custom layers

When working in surveillance or archive mode, user-specific layers can be added and
saved for each user separately. These custom layers can be defined and deleted by
the user without any additional user right.

Fig. 54: Custom layers

1. To open a layer, select the Layer in the top bar.

Surveillance mode

Custom layers
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Surveillance mode

Custom layers

Opening and closing a layer directly in a custom layer

1. Double click on a window to enlarge the layer.

2. Double-click on an enlarged layer to reduce its size to the preset state.

Adding a layer

1. Select Add layer and select the required arrangement of the layer fields or

select a user-defined arrangement of rows and columns. The new layer is

displayed.

2. Drag the tile (e.g. camera views, webpages, or maps) from the control bar

into the fields and click Save layer as personal layer to save the new layer

view for the current user on the server.
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Migrating local layers

Personal layers have previously been named "local layers". Personal lay-
ers are stored on the server for each user account, so they can be
accessed from any client the user is logged in to.

1. Select Migrate personal layer to convert all local layers located in localap-

pdata/qognify (or localappdata/seetec if it is an older installation)

to the new personal layers. The .xml files of the old layer settings will be

REMOVED after the process is finished successfully.

Expanding a layer

1. Select Add layer and select the required arrangement of the layer fields or

select a user-defined arrangement of rows and columns. The new layer is

displayed.

2. Select Edit layer and select any optional layout that provides additional tiles

(unavailable tiles are disabled). The current layer tab is set to the new layout.

Opening a layer in the secondary window

1. Click Open layer in secondary window to move the new layer to a sec-

ondary window.

Changing a layer automatically

1. Click Automatic Layer change and select a time interval after which the next

open layer is displayed.

Loading a personal layer

1. To open an existing layer, click Load personal layer and select the layer.

Surveillance mode

Custom layers
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Surveillance mode

Camera image controller

Deleting personal layers

Local layers must be migrated to personal layers before they can be
deleted ( see "Migrating local layers" on the previous page).

1. To delete a layer, click Delete personal layers.

2. Select the layer(s) to be deleted and click Delete layers.

Closing layers

1. To close a single layer, select Close layer or click the "x" layer tab.

2. To close all open layers, select Close all layers. Unsaved layers will close

without further notice.

Camera image controller

You work with the images of the connected and configured cameras directly in the cam-
era layer in the work area.

These functions refer only to the control options offered by Qognify VMS.
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Camera image control icons

Fig. 55: Camera image control icons

n Zoom . Enlarges the image detail with the help of the digital or optical zoom

function.
— The image detail is enlarged or reduced in size using the scroll wheel on the

mouse.
— You can move the zoomed image by holding down the middle mouse button.
— Optionally, when drawing a rectangle in the image while pressing the left

mouse button, the enclosed area will be zoomed into.
— PTZ cameras can be operated using the controller or a connected joystick.

For some PTZ cameras, zooming into a defined rectangular area in an

image by optical zoom is enabled.

Optical zoom is only possible if supported by the camera model.

n PTZ . Moves the image detail in the layer. The image detail can be changed

by clicking and moving the mouse pointer in the image (see "Camera image con-

troller" on the previous page). PTZ cameras can be operated using the controller

or a connected joystick (see "Swiveling the camera in the image" on page 92).

Surveillance mode

Camera image controller
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Surveillance mode

Camera image controller

n Layer options . Shows additional options:

— Tracking data: Displays the specified rules and detected for this camera

(e.g. tripwires) in the view.
— Display statistics: Displays statistical data on the image stream between the

camera and the DeviceManager server and between the DeviceManager

server and the client (see "Camera image statistics" on page 93).
— Activate privacy masking: Activates or disables privacy masking. The set-

tings for the camera are made in configuration mode in the Cameras area.
— Deselect: Deselects the selected camera.
— Rotate Image (180°). Displays the camera image rotated by 180° rotation

when the original camera image is displayed upside-down.
— Open in new tab: Displays the camera in a separate layer.
— Open in side window: Displays the camera in a separate layer in the first

secondary window.
— Close: Closes the active layer.

n Mini Archive mode . Shows the recordings of the selected interval (see

"Mini archive player" on the facing page).
— The interval can be between 5 and 60 seconds and is displayed or selected

by clicking the icon.
— When selecting Jump to time you can easily jump to a certain time point of

the recording.

n Audio mode . Controls the cameras' audio feature (volume / mute / per-

manent on)

n Export . Exports the current still image (video frame) as a JPEG file or prints

the still image displayed.

n Tile on 1x1 layer . Enlarges the tile so that it fills the full screen of the work

area. This option is only available when the tile is not in full screen display.

n Camera lock . Locks the camera for the user. Clicking the icon again

releases the camera for other users. The camera lock function must be enabled

in the Users settings in configuration mode.
n REC. Starts and stops manual recording. A red button on the right indicates if an

alarm recording has started.
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n Recording status : Indicates the recording behavior for the camera. A green

dot stands for standard recording, a red dot stands for alarm recording . A blank

black background stands for "no recording".
n Positions (1). Indicates the preset positions of the selected camera. The camera

positions are set in configuration mode in the Cameras area. To control the set

positions, see "Camera control" on page 97.

Mini archive player

The mini archive player allows control of the playback from a selected camera. More
extensive archive functions are available in archive mode (see "Archive mode" on
page 111).

Fig. 56: Mini archive player

The mini archive player provides the following functions:

n Fast rewind (1): Click once to play the recording backwards at double speed.

Click twice for four times the speed.
n Previous frame (2): Jumps to the event's previous frame or JPEG image.
n Play backward (3): Plays the archived video stream in reverse chronological

order.
n Pause (4): Pauses the playback.
n Play forward (5): Plays the archived recording in the correct chronological order.
n Next frame (6): Jumps to the event's next i-frame or JPEG frame.
n Fast forward (7): Click once to play the recording forward at double speed. Click

twice for four times the speed.
n Calendar (8): Opens a calendar window in order to jump to a specific point in

time.
n Add bookmark (9): Adds a bookmark to the current frame (see "Working with

bookmarks" on page 125).

Surveillance mode

Camera image controller
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Camera image controller

Manual alarm recording

Alarm recordings can be started and stopped manually by the user who has started
them. Additionally, bookmarks can be added to the recording. Bookmarks can be used
for the search in archive mode (see "Searching for alarms" on page 123).

Starting manual alarm recording

1. Click the REC button (10, see above). A red bell on the right indicates whether

alarm recording has started.

To prevent unlimited recording, the maximum post-alarm duration must

be specified in configuration mode in the camera settings.

2. Optionally, click Add bookmark. A bookmark information window is displayed.

3. Enter the name and a short description of the bookmark.

4. Click OK to add the bookmark to the recording.

Stopping manual alarm recording

1. Click the REC button again. The recording is stopped.

2. Optionally, add an additional bookmark.

Swiveling the camera in the image

The camera can be moved in pan and tilt mode in the image. Swiveling the camera
sideways is called "panning" (creating a panoramic effect), whereas swiveling the cam-
era up and down is called "tilting".
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1. Click PTZ . A red cross appears in the center of the image.

2. Click a point next to the cross. The distance of the point you click from the center

of the cross determines the speed of the swivel operation in the relevant dir-

ection.

3. If you like, you can activate the zoom function of the PTZ camera. Using the

mouse wheel, zoom in or out of the image.

4. Click PTZ again to deactivate the swivel function in the image.

When configured in the PTZ camera, the name of the user is displayed in the
image during operation. During non-user interactions like alarm scenarios or
sequences, "System" is displayed.

Camera image statistics

1. Select Layer options in the camera tool bar.

2. Select Display statistics. The statistics window remains open.

3. Close the statistics window by deselecting Display statistics in the Layer

options .

The camera image statistics show information about the following details:

n The video images which are rendered by the client. The Decoding (fps) should

be similar to the Rendering (fps),
n The video images which are recorded on the server,
n The quality of the audio stream,
n The network quality. The Packet loss (%) ratio as well as the Max. Jitter (ms)

value should be as low as possible. High values indicate network problems, e. g.

jitter may be caused by electromagnetic interference and crosstalk with carriers

of other signals.

Maps

A map shows an area to be monitored. In configuration mode it is added to the software
as a simple graphic. The various cameras and other functional icons are then integ-
rated into this graphic. The map can thus show a variety of different parts of the com-
pany: from the company site to fully automated production lines.

Surveillance mode

Maps
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Surveillance mode

Maps

The map shows the cameras that the user can only.

If a camera has failed (due to power failure, no connection to the network, etc.),
the camera icon is shown as a yellow warning sign.

Fig. 57: Maps

1. Select Digital zoom ( ) to activate the zooming function for the map.

2. Zoom the map detail by turning the mouse wheel while the mouse pointer is on

the map area.

3. Select Layer options ( ) to open the map on a new tab or in a new window or

to close the layer.

4. Select Create lasso selection ( ) to activate the lasso function. The lasso

function is activated by default.

5. Draw a lasso around the cameras to be displayed in a layer (see "Using the lasso

function" on the facing page).

6. Select Window on 1x1 layer ( ) to increase the size of the image to fill the

whole work area.

Displaying a camera preview

1. Move the mouse pointer in the map to the desired camera. A preview of the

camera image is displayed.
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2. Click the camera symbol to open the camera image in a new layer.

Using the lasso function

Up to 16 cameras can be “caught” by the lasso function.

1. Click Create lasso selection to activate the lasso function.

2. Hold the left mouse button pressed and move the mouse pointer around the

cameras you want to select. The movement of the mouse pointer is high-

lighted by means of a red line.

3. Release the mouse button. The selected camera images are displayed in a

new layer.

Web pages

In the web page layer, the user can call specific web pages in specified tiles in order to
receive information on the company, for example. The (Internet or intranet) web pages
displayed are specified in configuration mode.

1. Navigate in the web pages as in a browser. The navigation bar typically found in

browsers is not displayed.

Surveillance mode

Web pages
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Overview

2. To display the page in its own layer, click Full screen. The following navigation

controls are available:

— Back : Returns to the previous page.

— Next : Moves forward to the next page.

— Start page : Returns to the start page. The start page is the page spe-

cified in configuration mode.

— Reload or Cancel loading : Reloads the displayed page or stops

loading the page. Reloading is only possible after the page is loaded. If the

page loads too slowly, the loading can be canceled.

Overview

The Overview control displays all available cameras, maps, layers and web pages clas-
sified by the locations of the company.

Fig. 58: Overview

1. Click the small triangle in front of the name of the site to display all of the objects

assigned to this site.

2. Select an object from the list to display only this object.

Searching for an item

In the system's configuration settings, each item should have been given its own name.
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Fig. 59: Searching for an object

1. To search for a specific item, enter the name of the item in the Search text box

(see "Searching in surveillance mode" on page 109).

Camera control

Fig. 60: Camera control

The Camera control allows you to control the active cameras displayed in the work
area.

n PTZ : starts the PTZ control function to operate with PTZ cameras

n Buttons : starts the button function for triggering preset processes

n Patrol : starts the patrol operation for starting a set of surveillance oper-

ations

n Audio mode : starts the audio mode for communication

n Dispatcher : starts the dispatcher mode for operating the video wall

PTZ control

Selected PTZ cameras are operated with the PTZ control. PTZ-related functions are
available for PTZ cameras only. If no PTZ camera is selected or the PTZ function of the
camera is deactivated, only digital zoom and digital preset selection is possible.

Surveillance mode

Camera control
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Camera control

Using the PTZ control

Fig. 61: Using the PTZ control

1. On the menu bar of the control, click PTZ control to switch to the operating

mode of the cameras.

2. Select the camera image, and use PTZ control (1) to move the camera by

moving the bright spot in the desired direction.

3. Drag the Zoom slider (9) up or down to make the camera zoom in or out of

the image. Optionally, click the four direction arrows at the PTZ control to

move the camera incrementally.

Using preset positions

Including the default position, ten preset positions are available by direct selection
on the number field (8). More can be available in the drop down menu. The max-
imum number of presets depends on the camera. To edit preset positions in sur-
veillance mode see "Editing camera preset positions" on page 100. In general,
positions are set in the configuration mode by an administrator in the Camera
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area.

1. Click the required camera position on the number field (8) to pan the camera

to the selected position.

2. Optionally, click the triangle beside the position name, and select the desired

position from the drop-down list. The position is immediately approached.

Using multiple preset positions of a single camera in a single layer

Instead of using a fish-eye camera for a 360° view, multiple fixed camera images
can be combined in a single layer (for layers in surveillance mode, see "Custom
layers" on page 85).
Saving a layer remembers the camera position (digital preset, digital zoom,
dewarping position) and when opening again will resume at the same position.
This applies to saved layers in configuration mode as well as for personal layers.
Layers that are inserted into a video wall by drag & drop will retain the digital cam-
era position on the video wall.

Exposure and focus setting

The following exposure and focus settings are available only if supported by the
camera:

n Iris settings (2)
n Iris +, Iris -: Opens or closes the iris of the camera to control the bright-

ness.
n Auto Iris: Automatically adjusts the iris opening to the optimum bright-

ness of the environment.
n Autofocus: automatically adjusts the image sharpness to the objects

in the camera focus.
n Day- and night mode settings (3)

n Day mode, night mode: The camera sets a filter when light conditions

are poor.
n Auto: The camera switches between daytime and nighttime vision

automatically.

Surveillance mode
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n Focus settings (4)
n Close-up focus, Close-up focus: adjusts the image sharpness to the

objects in the camera focus, depending on the distance of the object

to the camera sensor chip.
n Autofocus: automatically adjusts the image sharpness to the objects

in the camera focus.

Editing camera preset positions

Camera (preset) positions can be defined (4), deleted (5) and edited (6) depending
on user rights.

Creating a preset camera position

1. With the PTZ control (1) move the camera to the required position.

2. Click Add new camera position (7). The new camera position is added

at the next free position number.

3. Enter a name for the position and click OK. The new camera position is

added at the next free position number.

Deleting a preset camera position

1. Select the position from the number field or from the drop down menu.

2. Click Delete (6). The deleted camera position is released, and sub-

sequent positions are shifted to compensate.

Example Position 3 is deleted. Position 4 is then shifted to position

3, position 5 to position 4 and so on.

Editing a preset camera position

1. Select the position from the number field or from the drop down menu.

2. Click Edit current preset (5).
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3. Edit the positions by means of changing the position name, PTZ-set-

tings, focus settings etc.

4. Click Save current changes.

Buttons

Starting actions and processes with buttons

Actions or defined processes such as camera recordings or alarm scenarios are
started with buttons.

Fig. 62: Buttons

1. On the menu bar of the Control control, click OK to switch to the display of

the buttons created.

2. The buttons that the user is authorized to use are displayed.

3. Activate the desired action by clicking the button.

Patrol

Patrols can display cameras, set positions, maps and layers one after the other for a
specific period. It is also possible to open or close digital outputs in a patrol and confirm
checkpoints.

1. On the menu bar of the control, click Patrol to switch to the overview of the

patrols configured.

Surveillance mode
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Starting a patrol

1. Select the desired patrol, and select Play . The defined cameras, preset

positions, maps and layers are displayed one after the other for the specified

period.

Stopping a patrol

1. Select Stop to cancel the selected patrol.

Pausing a patrol

1. Select Pause to interrupt the patrol. The patrol is paused.

Repeating a patrol

1. Select Loop . The patrol is repeated.

2. Select Loop again. The repetition is canceled, and no more patrols are

carried out once the current patrol is finished.

Navigating between points in the patrol

1. Click Back or Next to go to the previous or next item in the list.

Audio

1. On the menu bar of the Control control, click Audio to switch to audio mode.

For audio, the following options are available (if supported by the hardware).
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VoIP

Fig. 63: VoIP

1. Select VoIP to select voice output over the network (Voice over IP).

2. Move the sliders for the microphone (1) and loudspeakers (2) to adjust the

volume. The volume setting is saved locally for each client.

3. To speak to a person from the address book of the existing users, enter the

name of the person in the text box, and click the magnifying glass icon or

select a person from the list.

4. Click green phone (5) to start the call.

5. Click red phone (4) to finish the call. The name of the person you are talking

to, the person's location and the duration of the call are displayed (2).

6. Click DTMF (3) to send a DTMF-sequence or call a button action. The

sequence or button action is set by an administrator in the VOIP con-

figuration.

Camera

If supported by the camera, audio transmission from the client to the camera is pos-
sible.

Surveillance mode

Camera control

103 / 144



Surveillance mode

Camera control

Fig. 64: Camera

1. Select Camera to select the direct audio system of the camera (if available).

2. Move the slider for the loudspeaker (1) to adjust the volume. The volume set-

ting is saved locally for each camera.

3. To start audio communication to the camera press and hold the talk-button

(2).

4. To stop audio communication to the camera release the talk-button (2).

Dispatcher mode

Dispatcher mode is displayed only if the video wall dispatcher is activated in the

View menu (see "Video wall dispatcher" on page 40). In addition, at least one

video wall must have been created in configuration mode.
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Using the Dispatcher mode

Fig. 65: Dispatcher mode

1. On the menu bar of the control, click Dispatcher mode to switch to video

wall control.

2. Select the set video wall (3). The video wall is displayed , including the mon-

itors (1) it contains.

3. Click Digital zoom (2) and scroll with the mouse wheel to zoom in or out.

4. Press the mouse button and drag the display icons left or right to see adja-

cent displays.

5. Drag the desired video sources, layers and maps to the monitor in the thumb-

nail (1).

6. If necessary, open the display of the monitor by-clicking it. The monitor with

the active layers is displayed in the work area. You can drag the video

sources, layers and maps directly into the work area if the video wall monitor

is displayed.
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Alarm list and system messages

Alarm list and system messages

Fig. 66: Alarm list and system messages

The alarm list is at the bottom of the screen and can be opened or closed as required. It
displays the combined list of alarm and system messages in the order of their occur-
rence. The most recent alarms are displayed first. In addition, the number of alarms
that have occurred is shown in the surveillance mode icon on the mode bar.

1. To sort the alarm or system messages by the column category, click the column

headings.

2. To change the status of an alarm, select the object in the column Status and

select the status from the drop-down menu.

3. To collapse or expand the alarm list, click Expand / collapse all .

Alarm messages

All open alarms that have been assigned to the current logged-in profile are displayed
in the alarm messages. The type of alarm can be recognized by the color-code. The
color in which the alarm is displayed can be set in configuration mode in the alarms con-
trol.

Changing the alarm status

An alarm has the following statuses:

n Activated: This alarm is currently active.
n Confirmed: These alarms have been viewed and will be removed from the

alarm list. These alarms are removed from the alarm list for all users.
n Deferred: These alarms have been viewed and declared as important by the

applicable user (e.g. security guard), because they will be required at a later

time (e.g. for the patrol report). These alarms are retained in the alarm list.

Deferred alarms are declared open at the next start.
n Rejected: These alarms are removed from the alarm list and considered

unimportant or not applicable by the user.
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1. Click the entry in the Status column of the alarm list to change the status of

the alarm messages.

2. Optionally, click Confirm all to acknowledge the alarms and remove the red

circle displaying the number of unconfirmed alarms.

Classifying an alarm

Every alarm on the alarm list can be classified according to the categories defined.

1. Select the alarm in the alarm list.

2. Select the category from the drop-down list in the column Classification.

Message window (pop-up)

Fig. 67: Message window (pop-up)

As soon as an alarm occurs, a message window is displayed for high or medium
priority alarms.
Low priority alarms are removed from the alarm list at the end of the alarm if they
are acknowledged and another alarm occurs. Low priority alarms do not have an
alarm status.
You can add a comment for this alarm. The comment is displayed in report mode
and archive mode.

1. Click Confirm to acknowledge the alarm. The alarm is deleted from the

alarm list and the next alarm is displayed.

Surveillance mode

Alarm list and system messages
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2. Reject the alarm. The alarm is deleted from the alarm list and the next alarm

is displayed.

3. Reset the alarm. The alarm is marked as deferred in the alarm list. No fur-

ther alarm is displayed until an alarm is either called from the alarm list or

acknowledged. This allows multiple alarms to be acknowledged sim-

ultaneously.

Alarm notification

A new alarm is displayed in a highlighted pop-up window that opens from the bot-
tom of the screen (alarm notification).

Fig. 68: Alarm notification

The notification window displays the alarm name, its status and the time of occur-
rence.

1. Click Switch off notifications to prevent the alarm notifications appear on

the screen.

2. Select the time interval for the alarm message to be hidden ("snooze"). After

the selected interval has elapsed, the alarm notification will be displayed

again.

3. Select the alarm and click Edit to display the message window for editing.

4. Click Close to close the message window.

108 / 144



System messages

The system messages show the errors that have been reported by the system, such as
failure of a server, database or camera and also losses of connection.
The errors are displayed in descending order by time of occurrence with a description,
the internal error number, the message and the cause of the error.

1. Select one or more system messages and click Remove selected to remove the

message from the list. The number in the red circle displaying the number of

unconfirmed messages is reduced.

2. Optionally, click Remove all to remove all system messages from the list and to

remove the red circle displaying the number of unconfirmed system messages.

Searching in surveillance mode

The search below the overview tab in the control bar helps you to find the contents of
the active control bar more quickly.
If labels have been assigned to entities such as cameras, they can be used for search-
ing, helping to narrow the search.

Searching for labels is not displayed if no labels are configured or no entities
have been assigned to any label

Fig. 69: Searching in surveillance mode

1. Enter the search term into the search field (1). The first term found in the over-

view is highlighted.

2. Click the magnifying glass on the right of the search field or click [Enter] on the

keyboard to highlight the next term in the overview.

Surveillance mode

Searching in surveillance mode
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Searching in surveillance mode

3. If configured, select one or more labels from the drop-down list “Labels” (2) and

select OK. You can combine searching in the search field and filtering by labels

to narrow down the results. Only results that contain both the search text and the

labels are displayed (AND relationship).

n Filtering for an entity using a label displays the entities for that label even if they

are also labeled with more than one label.
n Filtering for an entity using multiple labels displays the entities that have one or

multiple labels assigned.
n Using the search term and labels at the same time displays the entities with the

search term and the entities with the labels assigned.

You can only see labels for entities for which you have the appropriate

user rights.

Displaying search results in a temporary layer

1. Drag and drop the entity or its containing folder or branch onto the work

area. The search result opens a new layer. When the results are within a

folder or branch, you can drag & drop the whole branch or folder onto the

work area. Only the filtered results are displayed, however.

When 4 layers are populated with up to 16 search results each, you

are required to consent to adding more layers. Opening more than 64

results may take considerably longer.
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Archive mode

Archive mode is used for the retrospective evaluation of recordings. Only recorded
data can be displayed in archive mode. To select the relevant image data, a camera
must be selected in the camera overview or in the "Alarm list and system messages"
on page 106.
The recording periods for the selected camera (green frame) are displayed in a time
line in the "Archive player" on the next page. The icons for digital zoom and volume con-
trol are also displayed (only for cameras with audio recording activated).

1. To switch to archive mode, click Archive mode in "The mode bar" on page 76.

2. Select the camera or layer whose archived image data is to be displayed, or

select an alarm from the alarm list.

Camera overview

The camera overview displays all installed cameras, maps and layers you are per-
mitted to access. Cameras having integrated exported image data are displayed as
"<camera name> [archive]".

1. Click the corresponding camera. The camera images are displayed in the main

window.

5



Archive mode

Archive player

Archive player

Fig. 70: Archive player

The archive player allows control of the playback from a selected camera. The player is
divided into two sections. The actual archive player is shown on the left and timeline on
the right.
The archive player has the following functions:

n Bandwidth optimization options ( ): Depending on the license and con-

figuration an optimized video stream can be selected to reduce client and net-

work load.

n Previous frame ( ): Jumps to the recordings previous video frame.

n Play backward (3): Plays the archived video stream in reverse chronological

order.

n Pause ( ): Pauses the playback.

n Play ( ): Plays the recorded video in the correct chronological order.

n Next frame ( ): Jumps to the recordings next video frame.

n Real time ( ): Plays the event in real time.

n Next alarm recording ( ): Jumps to the selected camera's next alarm record-

ing.

n Skip pause ( ): Skips the pause between two recordings in playback mode.

n Calendar ( ): Opens a calendar window in order to navigate to a specific cal-

endar time (date and time).

n Zoom out from timeline ( ) or Zoom in to timeline ( ): Enlarges or

reduces the size of the display of the timeline. You can also zoom within the

recording period by clicking the timeline and then turning the scroll wheel on the

mouse.

n Update timeline ( ): Updates the camera's timeline. For manual syn-

chronization with edge storage recordings, hold down the CTRL key when click-

ing the icon.

n Add bookmark ( ): Adds a bookmark to the current frame (see ).
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n Bookmark overview ( ): Displays the overview of all bookmarks (see "Work-

ing with bookmarks" on page 125).

n Multiselection mode ( ): Sets a marker across multiple time streams.

n Set marker ( ): Sets the start and end markers for a selected area of the

timeline (see "Editing an area" on the next page).

Bookmarks are not supported in Viewer Mode / Qognify Viewer.

n Delete marking ( ): Deletes the selected marking.

n QogniFinder ( ): Starts the forensic search when the appropriate usage

rights are provided (see "Using the QogniFinder" on page 116).

n Synchronized mode ( ): All visible cameras are synchronized to the time of

the selected camera by default. If the synchronized mode is deactivated, each

camera can show a different point in time.

n Write protection ( / ): Sets write protection for the marked area of the

timeline. See "Write protection" on page 121

n Delete area ( ): Deletes the marked area from the timeline.

n Export area ( ): Starts the AVI export or the Qognify video data export (see

"Exporting recordings" on page 119).

Exporting in Qognify file format is not supported.

n Jog dial: Plays the sequence forward and backward. The further you turn the jog

dial to the right or left, the faster the sequence is played forward or backward.

The playback speed is displayed below the jog wheel.
n Timeline / time stream: See "Timeline / time stream" on the next page.

Using the jog dial

1. Turn the jog dial with the mouse to the left or right to play the sequence back-

wards and forward. When releasing the jog dial, it will return to the center pos-

ition.

2. Click on a dot around the jog dial to position it there.

3. Click on the double bar above the dial to release.
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Timeline / time stream

The time displayed in the timeline may differ from the time displayed in the
video due to the way Qognify VMS stores the timestamp information (refer to
Time zone handling).

The timeline / time stream allows you to search across the entire recording period for
relevant image material. The important color markings are:

n Green (standard recording)
n Red (alarm recording) - or any other color than green

1. Zoom into the recording period by clicking the timeline and turning the scroll

wheel on the mouse. This improves the overview of the recording start of the

camera.

2. Double-click any point in the timeline to move the selected point to the timeline

center.

Preview

1. Move the mouse over the timeline or move the timeline to display the preview of

the camera image at the selected time. The setting in the client configuration

must be defined as “Always On” (see "Client configuration" on page 16).

2. Optionally, keep the control key pressed when moving the mouse over the

timeline or moving the timeline. This will only display the preview with the control

key pressed. For this, the setting in the client configuration must be defined as

"Ctrl + MouseOver".

The preview feature is not available in the mini archive mode of a tile.

Editing an area

1. Click the camera time stream next to the jog dial. If one camera is played or mul-

tiple cameras are played synchronously, the current time of the archive is dis-

played next to the playhead. If multiple cameras are played asynchronously, the

current time of the archive is not displayed.

2. On the timeline, select Set start marker to mark the beginning of the sec-

tion. When setting markers simultaneously across multiple timelines, select Mult-

iselection mode first. When multiselection mode is active, the icon is green.

3. Move the time bar to the of the end of the section.
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4. Select Set end marker to specify the end of the section.

5. Select Delete area to remove the section from the timeline.

6. Click Export area to export the section.

7. Select the required data format (Type), and select OK. The following export

formats are available:

— Qognify data format: The exported data are password-protected and can

only be viewed with the viewer.
— AVI: The exported data are not password-protected and can be viewed with

any film software. This represents a high data protection risk.

8. Specify the required export settings (see "Multiple export of image data" on

page 56).

Click-2-Track

The feature is used in archive mode to navigate from one camera to the next by clicking
on the Click-2-Track regions in the image.
The preview of the Click-2-Track region shows the same point in time as the current
archive timeline. If the archive is in playback mode, the preview inset plays at the same
speed as the main image. The current speed and direction remains the same even
when switching between Click-2-Track regions and changing the camera.

The feature works with playback forward and backward at different speeds as
well as still images.

The history feature

Click-2-Track stores a history of the camera according to the following criteria:

n Each camera stores the time when it was opened and the time when it was

replaced by the next camera.
n When navigating to the next entry in history, the camera shows the opening time.
n When navigating to the previous entry in history, the camera shows the closing

time.
n Only the Click-2-Track uses from the current tile are saved in the history feature.

All tiles have their own history.
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Example

1. Camera A is viewed from 8:00 to 8:01, then the region for Camera B is

selected.

2. Camera B is viewed from 8:01 to 8:02, then the region for Camera C is

selected.

3. Camera C is viewed from 8:02 to 8:03, then the button Back in the history

is used. The view jumps to Camera B at 8:02 with a still image, regardless

of the previous speed.

4. When the button Back in history is used again, the view will jump to Cam-

era A at 8:01 with a still image.

5. Using the button Forward in history, the view jumps to Camera B at 8:01,

using it again jumps to Camera C at 8:02.

Using the QogniFinder

The QogniFinder interface uses the same language

QogniFinder must be enabled for the selected camera in configuration mode

(see Camera general).

1. In Archive mode, select the camera and select QogniFinder in the toolbar of

the Archive player. When multiple cameras are configured, they are displayed as

groups named according to the manufacturer's name.
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2. Select the camera(s) used to search for objects.

n If a camera does not support some search criteria, the corresponding

search criteria are highlighted.
n If a camera supports none of the search criteria, the camera is highlighted.

3. Define the Time range for the search by entering the start and end dates or

selecting one of the predefined filters:

n 30 m: the last 30 minutes
n 1 h, 2 h, 5 h, 10 h, 24 h: the previous interval of one hour up to the last 24 hours

4. Enable the primary search parameters:

n Human (face and body combined)

For supported cameras from Hanwha, the search criterion "Human" also

includes criteria such as "Hat", "Bag", etc.

n Vehicle

For supported cameras such as specific cameras from Hanwha, Axis, or

Bosch, the search for "Vehicle" also displays the vehicle type as cri-

terion.

5. To define the search parameter, click on the enabled parameter(s) and specify

further metadata such as clothing color or vehicle type.

Archive mode
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6. Close the selection window and click Search. The objects within the specified

time range and all images meeting the specified search criteria are displayed.

7. If more the 16 results are found, use the paging function at the bottom of the win-

dow to navigate to more objects or narrow the search by adding parameters or

changing the time range.

8. To see the details of a result, move the mouse over the preview and click on the

camera icon . The search parameters are displayed along with the selected

scene.

9. If more than one result is found, navigate to the next or previous result using the

buttons and .

10. To start a search with other parameters, select Reset and define the new search

parameters.
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Exporting recordings

Exporting a single frame

1. In the frame tile, select Export in the tile bottom.

2. Select the export format:

— Save video frame in file. This saves the selected frame as a static

image file (JPG).
— Print video frame. This prints the selected frame as hardcopy with addi-

tional information such as camera and recording time.

Exporting a video file

1. Set the time range for the export by moving the recorded section and setting

the marker at the start and end points.

2. Use the multiselect marker to select multiple timelines at once by pla-

cing it on the timeline of one camera. All camera timelines at the same ver-

tical selection are marked.

3. To remove a time range, select Delete marking and select the time

range(s) to be removed.

4. Select Export in the archive player controls.

5. Select the export type Video data export (password encrypted Qognify-spe-

cific format) or AVI export (unencrypted data format).

If video data export is selected, the recordings are exported to the

server or to the client (see "Multiple export of image data" on

page 56).

If the export process is interrupted, e.g. due to a network error, it will

automatically be resumed as soon as possible.

6. Proceed according to the required targets (for the following procedures, refer

to "Multiple export of image data" on page 56).
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Exporting the Click-2-Track history with the Export

Designer

When exporting an event with the Export Designer, the Click-2-track history can be
exported as well.

For the cameras with Click-2-Track enabled, this handover feature also works
in the "Anywhere Viewer" on page 139.

Fig. 71: Example of following a person in archive mode with Click2Track

1. Open the camera in the archive player.

2. Select Click-2-Track in the Layer options .

3. Select Activate and follow the shapes in the image sequence by clicking on the

respective shape. This opens the camera sequence of the assigned camera.
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4. Select Click-2-Track > Open history in Export Designer to start the Export

Designer (see "The Export Designer" on page 48). The Click-2-Track history of

the camera is displayed in a list as sequences.

5. Click on a privacy mask to include or exclude the privacy mask in the export.

Privacy masks cannot be hidden in offline mode.

6. To delete a sequence from the export, select the sequence and click Delete

. By default, all sequences are exported.

Evaluating exported video data

There are two options for evaluating the exported video data:

n On a system without a Qognify VMS installation, the video data can be evaluated

using the Qognify VMS Viewer (see "Anywhere Viewer" on page 139).
n To integrate the video data within a Qognify VMS installation, an "archive cam-

era" must be created in the configuration mode.

Write protection

Write protected recordings remain in the zone directory and will not be deleted.
Make sure that sufficient disc space on the zone partition is available.
Due to legal regulations, write protection may not be used for installations in
France.

Set write protection

The protected range in the timeline is at least as wide as the range selected by the
user, as Qognify VMS may protect a wider range, for example to optimize the per-
formance of the Multimedia Database (mdb). The actual protected time range is

Archive mode

Write protection
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Archive mode

Write protection

displayed after setting the write protection.

1. On the timeline, select Set markers to mark the beginning of the section to

be protected.

2. Move the time bar to the of the end of the section to be protected.

3. Select Set markers again to specify the section.

4. Select the closed padlock to protect recordings from being overwritten

or deleted.

Remove write protection

1. Select Open padlock ( ) in the Archive player.

Fig. 72: Remove write protection
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2. Select Start query.

3. Select the write protected sequences. Hold the CONTROL-key to select mul-

tiple sequences.

4. Select Remove write protection.

Searching for alarms

The time displayed in the timeline may differ from the time displayed in the
video due to the way Qognify VMS stores the timestamp information (refer to
Time zone handling).

With the alarm search you can search for specific alarm depending on configurable con-
ditions.

Creating an alarm query

Fig. 73: Searching for alarms

1. Click New request in the Alarm search control. The Alarm query is dis-

played.

2. Specify the Time period for the alarm to be searched.

Archive mode

Searching for alarms
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Archive mode

Searching for alarms

3. Optionally, select the recent time intervals of the last hour, the last 24 hours,

the last week, or the current day.

4. Select the “Alarm scenario”, either by name or by priority.

— To select all items, click Select all.
— To deselect, click Delete selection.

5. Select the “Alarm classification” either by direct selection or by searching the

classification term.

6. If available, enter the additional information that is obtained by network trig-

gers (e.g. Network IO) to be searched for.

7. Select Manual alarm recording to include manual recordings of the avail-

able video sources in the search.

8. Select the recordings of the camera or cameras to be searched.

9. Click OK to start the search.

Alarm search results

The results of your alarm query are displayed in the Alarm search control.
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Fig. 74: Alarm search results

1. Click on one of the column headings Priority, Name or Time to sort the res-

ults accordingly.

2. Click on the on the arrow on the left of an alarm to display details.

Working with bookmarks

Bookmarks can be set in archive mode or when starting or ending a manual alarm
recording (see "Manual alarm recording" on page 92).

Archive mode
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Archive mode

Working with bookmarks

Adding a bookmark

1. Move the timeline to the position where you want to set the bookmark.

2. Select Add bookmark ( ) in the Archive player.

3. Enter a Name for the bookmark.

4. Select the Camera for which you want to bookmark the recording from the

drop-down menu. The drop-down menu contains all cameras in that are cur-

rently displayed in the archive player. By default, the currently active camera

in the archive player is selected.

5. Enter a description, if required.

6. Select Add bookmark. A flag will be added to the time line of the selected

camera.
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Bookmark overview

In the bookmark overview, bookmarks can be displayed, edited and deleted.

1. Select Bookmark overview ( ) in the Archive Player.

2. Select one or more cameras or click Select all to select all cameras dis-

played (i.e. cameras with bookmarks attached).

3. Optionally, search for the camera name or the bookmark.

4. Search bookmarks for all cameras even if only visible in the archive. Book-

marks from cameras of different installations can be searched sim-

ultaneously.

5. To deselect, click Cancel selection .

6. Enable Search within a range to narrow the time window for the search and

specify the time interval.

7. Select Start search to display only the bookmarks within the specified time

interval. The bookmarks are displayed in the "Bookmarks" section.

8. Select a bookmark from the "Bookmarks" section. The information asso-

ciated with the bookmark (time, the assigned camera, and the description) is

displayed in the right area.

Archive mode

Working with bookmarks
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Archive mode

Edge storage import

9. Double-click on the bookmark to navigate to the corresponding time marker.

10. To edit the information, select Edit ( ) (see "Adding a bookmark" on

page 126).

11. To delete the bookmark, select Delete ( ).

Bookmarks are not deleted with the video data, because they are stored in
a separate event database. They are deleted automatically, once the old-
est video image is newer than the time stamp of the bookmark.

Edge storage import

Edge storage uses the camera to store images on an internal storage media (e.g. SD
card) to cover connection failures between the camera and the database server. If the
connection between the camera and the server is interrupted, recording gaps on the
DeviceManager will result.
After the connection is reestablished, the recording gaps on the server can be filled
with the recordings from the camera's internal storage media. Time schedules for
recording and maximal recording size are taken into consideration..
Depending on the configuration of the camera, edge storage data can be imported auto-
matically or manually.

Manual edge storage import

1. For manual edge storage import, hold down the CTRL key when selecting

Update timeline .

iSearch

iSearch in archive mode searches recordings for motion in specific image regions. The
searchable time period is 5 to 60 minutes.

The performance of iSearch depends on the performance capability of the cli-
ent hardware, since the search is carried out exclusively on the client.
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Configuring iSearch

1. Select the related camera.

2. Click iSearch at the bottom of the video image and select a time range

between 5 and 60 minutes. The maximum selectable time range depends on

the access restrictions of the user for the archive.

A dotted rectangular icon is displayed on the right side of the iSearch button.

3. Click on the area icon and select the shape of the search area. The following

shape options are available:

— Rectangle
— Circle / ellipse
— Polygon
— Delete shape
— Delete all shapes

Archive mode

iSearch
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Archive mode

iSearch

4. In the camera image drag the selected shape to the desired position. A

semi-transparent area is laid over the image in the selected position.

If you selected the polygon for this purpose, click a point in the image

for each corner and close the polygon by double-clicking the last

point.

Fig. 75: Configuring iSearch

5. Within the selected area, select either Any kind of motion (default) or A

single event.

— Any kind of motion: This search method searches for all changes within

the image in the specified period. The search can be performed for the

whole image or for parts of the image as specified by the user. The

search may take some time depending on the selection.
— A single event: This search method is particularly quick. It is possible to

search through several days of image material in a few seconds.

However, this method only works if a single, lasting event has occurred

in the camera's selected field.

6. Optionally select Expert mode to fine tune the search.

iSearch in expert mode

Fig. 76: iSearch in expert mode
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1. Specify the desired settings and start the search. The following options

are available:

n Dead time in seconds specifies how much time has to elapse after

motion detection in the image or part of the image before another hit is

displayed in the result list.
n Threshold detects changes in the image when the camera is operating

in extreme light conditions. A change in the image is interpreted as

"motion" if it exceeds the threshold. The higher the threshold, the

greater the change in the image must be before it is considered to be

"motion".
n Maximum number of frames per second if not all of the recorded

frames have to be searched. This can speed up the search sig-

nificantly.
n Maximum pixel limit for interval search: The maximum pixel limit for

an interval search only has an impact on searches for a lasting change.

The specified start and end points of the period in which the search is

to be carried out are compared continuously. If the two points currently

diverge by more than the specified pixel limit, interval bisection is inter-

rupted, and a serial search with greater increments is started until the

pixel limit is adhered to again. The interval search is then resumed

from this point. This setting improves the search under extreme lighting

conditions (strong contrast between light and dark areas or objects

passing).
n Show help dialog after single search, if appropriate. On completion of

the search, you can specify in a dialog whether or not the event has

been found and whether you want to switch to archive mode with the

event found.

2. To exit expert mode, select Normal mode.

Deleting a search area

1. Click the search area, and select Delete to delete only the selected area.

2. Optionally, select Delete all to delete all areas.

Archive mode
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Report mode

Report mode gives you an overview of the events that have occurred in the form of a
list. Distinctions are drawn between:

n User events (display of events that concern specific users)
n Alarm events (events that have occurred)
n Camera usage (display of events that concern a specific camera)
n System messages (display of events that concern specific services)

In addition, the camera usage of users can be tracked and the user can see which
changes have been made to the configuration and by whom.

The maximum number of events to be displayed can be specified in the client
configuration (see "Client configuration" on page 16).
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Report mode

1. To switch to report mode, click the Report mode icon on the mode bar.

Fig. 77: Report mode

2. Click a column header in the main window to sort the events in ascending or

ascending order based on the column's category (date / time, user, description).

Filtering the query

In report mode, the following event types can be evaluated:

n Alarms can be filtered for alarm scenarios
n Users can be filtered for:

— Users
— Camera configuration
— Archive
— Export
— Patrols
— Actions
— Log on or log off
— Failed logins
— Change mode
— Sharing and restriction events

n Camera usage can be filtered for:
— Camera (only if the DeviceManager records camera usage)
— Users
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n System can be filtered for:
— Core services
— Image storage

Depending on the area, the query results can be filtered.

1. To filter the events on the basis of specified criteria, select the type of event

you are searching for on the Query for control bar.

2. Select the user or users related to the events to be searched for.

3. Select the desired events. The items are displayed in the list below.

4. Select specific items by clicking the check box in front of the item's name or

click select all.

5. To deselect, select Delete selection.

6. To further narrow the selection, specify dates and times to define the time

period.

7. Start the query. Only the events that meet the selected criteria are displayed

in the main window.

Exporting the analysis as spreadsheet file

You can also export the result as a comma-separated file (*.csv).

1. Export the result in order to analyze it in a spreadsheet program.

Report mode
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Report mode

Saving a query as report template

Additionally, the search criteria can be saved for future queries.

1. In the report mode window, select Save.

Fig. 78: Saving a query as report template

2. Enter the Report template name.

3. Optionally, select Save timestamp relative to current time. This option will

use the time interval of the current query for the next query.
Example The current query searches for events within the last 24 hours.
When the query is saved with a relative time stamp, the next query will also
search within the last 24 hours - relative to the next query.

4. Select OK to save the query.

Using a previously saved query

1. Select the name of the query in the drop-down menu and select Start

query.

Deleting a saved query

1. To delete the saved query, select the query from the drop-down menu

and select Delete.
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Shortcut keys

The following keyboard shortcuts are available for users in the client to speed up func-
tion calls.

More shortcuts are available and configurable in the client configuration (see
"Keyboard shortcuts" on page 31).

Shortcut key Meaning

CTRL+1 Switch to surveillance mode

CTRL+2 Switch to archive mode

CTRL+3 Switch to report mode

CTRL+4 Switch to configuration mode (only possible as administrator)

CTRL+5 Switch to LPR mode

CTRL-Y Display statistics in video image in Surveillance and Archive

mode

F10 Switch full-image mode on or off
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Shortcut keys

Shortcut key Meaning

F1 Show Qognify User's Guide

F2 Moves all windows to primary display (only when multiple dis-

plays are connected)

ESC Hide all controls

+/- When digital zoom is active, pressing + or - zooms in or out
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Anywhere Viewer

The Anywhere Viewer can be used to access exported image data that are in the
Qognify image format without connection to the database.

The Viewer displays recorded data only in Archive mode. All other modes are
not accessible as they require database access.

n The Viewer is automatically installed as a subset of the Qognify VMS client

installation. It can also be installed separately in a user-defined installation.
n The Viewer is exported to the export folder with any video data export.
n The Viewer manual is installed in the manual folder during installation.

When viewing files that are exported to the local hard drive of the client with the
Viewer, any local installation of the Qognify VMS client must be quit to prevent
conflicts.

1. Quit Qognify VMS if running as a normal client connected to a database.

2. Start the Viewer from within the export folder.
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Anywhere Viewer

Switching the interface language

Switching the interface language

Without a Qognify VMS client installed on the local hard drive, the language can
only be changed using command line parameters.

1. Exit the Qognify Viewer and start the Qognify VMS client.

2. Change the interface language in the File menu of the function bar in the Qognify

VMS client (see "Changing the language" on page 32).

3. Exit the Qognify VMS client and start either the Qognify VMS client in Viewer

mode or the Qognify Viewer.

Import and play recording

Import recording into the Viewer

1. Start the Qognify Viewer (see "Login" on page 7). The overview panel with

the available recordings is displayed.

2. To add additional exported camera sequences, select Add exported cam-

eras in the overview panel.

3. Optionally, navigate to the export folder of the recording and start the

Qognify Viewer in the folder.

4. Navigate to the folder where the files are located.
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5. Click OK to import the selected data into the viewer.

When opening a folder that contains multiple exported camera

sequences (even in subfolders), all files will be imported.

Fig. 79: File selection for importing into the Viewer in offline mode

6. Enter the password specified during export.

7. Apply the password and click OK. Any exported video sequence that

matches the password moves to the "Verified" section on the right. You can

enter and apply further passwords for additional video sequences.

8. Enter the password specified during export.

9. Apply the password and click OK. Any exported video sequence that

matches the password moves to the "Verified" section on the right. You can

enter and apply further passwords for additional video sequences.

Importing data into the Qognify Viewer may take some time.

10. Click the exported camera that you wish to view. Alternatively, you can drag

the desired camera to the previously occupied tile. If you imported multiple

sequences from the same camera they will be shown as one camera in the

tree. If you open this camera all the sequences of this camera can be found

in the same timeline.

Anywhere Viewer

Import and play recording

141 / 144



Anywhere Viewer

Import and play recording

Play recording

Fig. 80: The Qognify Viewer controls

The Viewer allows limited control of the playback from one or multiple exported
recordings in a single timeline. In Viewer Mode or in the Viewer you can use layers
to simultaneously display multiple cameras in a grid. Multiple timelines are dis-
played just as in the regular Qognify VMS client.
The Viewer has the following functions:

n Bandwidth optimization options ( ): Depending on the license and con-

figuration an optimized video stream can be selected to reduce client and

network load.

n Previous frame ( ): Jumps to the recordings previous video frame.

n Play backward (3): Plays the archived video stream in reverse chro-

nological order.

n Pause ( ): Pauses the playback.

n Play ( ): Plays the recorded video in the correct chronological order.

n Next frame ( ): Jumps to the recordings next video frame.

n Real time ( ): Plays the event in real time.

n Next alarm recording ( ): Jumps to the selected camera's next alarm

recording.

n Skip pause ( ): Skips the pause between two recordings in playback

mode.

n Calendar ( ): Opens a calendar window in order to navigate to a specific

calendar time (date and time).

n Zoom out from timeline ( ) or Zoom in to timeline ( ): Enlarges or

reduces the size of the display of the timeline. You can also zoom within the

recording period by clicking the timeline and then turning the scroll wheel on

the mouse.
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n Update timeline ( ): Updates the camera's timeline. For manual syn-

chronization with edge storage recordings, hold down the CTRL key when

clicking the icon.

n Add bookmark ( ): Adds a bookmark to the current frame (see ).

n Bookmark overview ( ): Displays the overview of all bookmarks (see

"Working with bookmarks" on page 125).

n Multiselection mode ( ): Sets a marker across multiple time streams.

n Set marker ( ): Sets the start and end markers for a selected area of the

timeline (see "Editing an area" on page 114).

Bookmarks are not supported in Viewer Mode / Qognify Viewer.

n Delete marking ( ): Deletes the selected marking.

n QogniFinder ( ): Starts the forensic search when the appropriate usage

rights are provided (see "Using the QogniFinder" on page 116).

n Synchronized mode ( ): All visible cameras are synchronized to the time

of the selected camera by default. If the synchronized mode is deactivated,

each camera can show a different point in time.

n Write protection ( / ): Sets write protection for the marked area of

the timeline. See "Write protection" on page 121

n Delete area ( ): Deletes the marked area from the timeline.

n Export area ( ): Starts the AVI export or the Qognify video data export

(see "Exporting recordings" on page 119).

Exporting in Qognify file format is not supported.

n Jog dial: Plays the sequence forward and backward. The further you turn

the jog dial to the right or left, the faster the sequence is played forward or

backward. The playback speed is displayed below the jog wheel.
n Timeline / time stream: See "Timeline / time stream" on page 114.

Export a recording

For information on exporting the recordings, refer to "The Export Designer" on page 48.

Anywhere Viewer

Export a recording
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